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Grundlegendes zu Beginn

Lernplattform OO basiert auf Moodle, einem der gréRten Lernplattform-Systeme der Welt, und hat die Standard-
Installation durch zahlreiche zusétzliche Plugins und Module erweitert, um sie bestmaoglich an die Anforderungen
im taglichen Betrieb anzupassen. Es handelt sich um ein kostenloses Angebot fir 06. Pflichtschulen.

Tipp: Sonstige Schulen und andere Bildungsinstitutionen haben die Maoglichkeit, tber unser Angebot
eduACADEMY ein vergleichbares Angebot in Anspruch zu nehmen.

Aufgrund der vielfaltigen Werkzeuge, Konfigurationsmoglichkeiten und Einstellungen, die auf lhrer Instanz
vorgenommen werden koénnen, ist es nicht moglich, lhnen in Form eines Handbuches die Verwendung dieser
Plattform im Detail naherzubringen.

Daher bieten wir Ihnen in diesen Unterlagen lediglich einen Uberblick iber die wichtigsten Funktionen und einige
ausgewadhlte Einstellungsmoglichkeiten. Fur detailliertere Informationen mochten wir Sie auf die umfangreiche
und laufend aktualisierte User-Dokumentation verweisen, die online zu finden ist.

Hinweis: Bitte beachten Sie, dass auf lhrer Instanz moglicherweise nicht alle angefiihrten Optionen vorhanden
sind bzw. die jeweiligen Elemente anders aussehen. Dies hangt mit dem gewahlten Design bzw. den fiir Sie
gesetzten Berechtigungen zusammen. StandardmaRig ist das Design ,,Boost” ausgewahlt. Daher wurde dieses
Design (sofern nicht anders angefiihrt) auch fir die Screenshots und Anleitungen in vorliegenden Unterlagen
verwendet.

Struktur einer Lernplattform OO-Instanz

Grundsétzlich ist eine Lernplattform 00-Instanz folgendermaBen aufgebaut:

Lernplattform OO-Instanz

erreichbar Giber eine von Ihnen gewdhlte Domain bzw. Subdomain

Kursbereiche

z. B. Schuljahr, Klassen ...

z. B. Facher

Kursabschnitte

z. B. Themenblécke

Aktivitaten und Arbeitsmaterialien

z. B. Foren, interaktive Ubungen, Aufgaben ...

Einfach gesagt steht Ihrer Institution mit einer so genannten Lernplattform OO-Instanz eine Seite zur Verfiigung,
die Gber eine von lhnen gewahlte Domain bzw. Subdomain erreichbar ist.

Auf der Instanz konnen Sie selbst dann Kurse anlegen, die in Kursbereichen organisiert sind. So kénnte
beispielsweise fiir jede:n Lehrer:n an einer Schule, fir jedes Fach oder fir jede Klasse ein eigener Kursbereich
angelegt werden, in dem dann die jeweiligen Kurse zu finden sind.
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Die Kurse selbst konnen wiederum in Kursabschnitte und -unterabschnitte untergliedert sein — ein Kursabschnitt

kann sich z. B. auf einen bestimmten Themenbereich beziehen, aber auch Kurswochen abbilden.

In den einzelnen Kursabschnitten finden sich die Lehr- und Lerninhalte (blau markiert): Die Vielfalt ist hier riesig

und reicht von Texten, Bildern oder Multimedia-Inhalten Gber Werkzeuge zur Kommunikation wie Chat oder

Foren bis hin zu Tools fur die Durchfihrung von Tests oder zur Bewertung der Lernenden.

Grundsatzlich unterscheidet man hier Aktivitdten und Arbeitsmaterialien, wobei Aktivitdten eine interaktive

Komponente fiir die Lernenden beinhalten und es sich bei Arbeitsmaterialien um statische Inhalte handelt, die

von den jeweiligen Trainer:innen im Kurs bereitgestellt werden.

Daneben kénnen noch weitere Informationen in Form von so genannten Blocken (griin markiert) in einer Instanz

untergebracht werden. Blocke finden sich zumeist in der rechten oder linken Spalte und kénnen z. B. fir die

Anzeige eines Kalenders, zur einfacheren Navigation oder fiir die Darstellung von Informationen verwendet

werden.

GS604 Antikes Griechenland

Fragensam

¥ 1. Einstiegsinfos

v Thema

DAS ANTIKE GRIECHENLAND

A Dk Gk Cidchediana | Dberbiick v @ sy

v 2. Athen & Sparta

Griechenland &

> 1. Einstiegsinfos

v 4. Kolonien

2. Athen & Sparta

> 3. Regierungsformen

v 4. Kolonien

Foren durchsuchen

= &

Aktuelle Termine

Die Griechen griinden Kolonien

¥ 6. Hellenismus

v 5. KAHOOT - Antikes Griec..

v 5. Spezialthema:

Gotter - Olympische Spiele - Theater - Kunst - Philosophie

Quelle: Screenshot eines Moodle-Kurses von Matthias Stollberger (CC BY-NC-SA 3.0)
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Rollen auf Ihrer Instanz

Die Zuteilung von Rollen und damit von Berechtigungen wird auf Ihrer Instanz hierarchisch vererbt:

Dies bedeutet, dass eine Person, die Rechte auf ST e
Systemebene hat, diese auch in Kursbereichen, Kursen und
Aktivitaten ausiben kann. Eine Person, die nur auf
Kursebene gewisse Rechte hat, hat diese zwar auch in den Kursbereich-administration

Aktivitaten im Kurs, aber nicht im jeweiligen Kursbereich.

Kursadministration

Administration von
Aktivitidten/Blécken

Der Administrator/Die Administratorin

Ihre Institution erhalt fur die Verwaltung und Gestaltung Ihrer Instanz ein Admin-Konto zur Verfligung gestellt.
Mit diesem haben Sie auf Ihrer Instanz vollste Rechte, um diese bestmoglich an lhre Bedlrfnisse anzupassen. Es
gibt hier nur einige wenige Einschrinkungen, die mit dem Systemaufbau von Lernplattform 0O
zusammenhdngen — beispielsweise ist die selbststandige Installation von Zusatzplugins durch Sie nicht moglich.
Im Anschluss an die Instanzanlage erhalten Sie als Administrator:in per E-Mail lhren Login-Namen und ein
Passwort Gbermittelt und kénnen sich auf lhrer Instanz einloggen.

Hinweis: Beim Anlegen einer Instanz wird nicht nur fiir Sie, sondern auch fiir unser Support-Team ein Admin-
User angelegt. Bitte diesen nicht |6schen oder bearbeiten, da wir diesen fiir die Bearbeitung lhrer Anfragen
bendtigen.

Die Rolle des Administrators bzw. der Administratorin einer Instanz nimmt eine Sonderstellung in der
Berechtigungsstruktur ein, da sie flir das System essentiell ist. Administrator:innen konnen andere
Benutzer:innen als Administrator:innen definieren; sie kénnen die Rolle selbst aber nicht bearbeiten oder
I6schen.

Das Hinzufiigen bzw. Léschen von Administrator:innen funktioniert unter ,Website-Administration >
Nutzer/innen > Rechte > Administrator/innen". Wir empfehlen, aufgrund der umfangreichen Berechtigungen,
die mit der Admin-Rolle einhergehen, sie nur wenigen Benutzer:innen zuzuweisen.

Weitere Rollen

Neben der genannten Admin-Rolle gibt es auf Ihrer Lernplattform grundsatzlich 8 fertig definierte Standardrollen
—néahere Informationen zu diesen finden Sie hier:

e Manager/in
kann in fast allen Bereichen der Seite Anderungen vornehmen, also z. B. auch Kurse verwalten und sie
verdndern.

e  Kursersteller/in (Course Creator)
kann neue Kurse anlegen und in ihnen unterrichten

e Trainer/in (Teacher)

717l Education
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hat innerhalb seines bzw. ihres Kurses volle Gestaltungsfreiheit und kann die Kurseinstellungen dndern,
Rollen zuweisen, Kursinhalte gestalten (Arbeitsmaterialien und Aktivitdten anlegen und bearbeiten),
Bewertungen vornehmen, Berichte sehen usw.

e Trainer/in ohne Bearbeitungsrecht (Non-editing teacher)
kann keine Kurseinstellungen oder Kursinhalte dndern, jedoch Bewertungen vornehmen, Foren
moderieren, Berichte sehen usw.

e Teilnehmer/in (Student)
nimmt an den Kursen teil und fihrt Aktivitdten aus

e Gast (Guest)
hat minimale Rechte und ausschliefRlich Lesezugriff

e Authentifizierte/r Nutzer/in (Authenticated user)
stellt sicher, dass eingeloggte Personen auch unabhangig vom Kurs-Kontext bestimmte Fahigkeiten
haben, wie z. B. das Verwalten von eigenen Kalendereintragen oder das Erstellen von Blogeintragen

e Authentifizierte/r Nutzer/in auf der Startseite (Authenticated user on frontpage)
legt die Rechte von eingeloggten Personen auf der Startseite fest

In der Rechteverwaltung kdnnen Sie Benutzer:innen gezielt und punktuell bestimmte Rechte einrdumen oder
vorenthalten. Auf Ihrer Instanz finden Sie zu jeder der moglichen Berechtigungen Hinweise zu moglichen Risiken.

Unter ,Website-Administration > Nutzer/innen > Rechte > Rollen verwalten” kdnnen Sie die Berechtigungen fiir
bestehende Rollen andern, neue Rollen erstellen oder I6schen. Wir empfehlen aber nur erfahrenen
Benutzer:innen, hier Anpassungen vorzunehmen.

N&here Informationen zur Anpassung von Rollen finden Sie auch hier.

7171l Education
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Fiir Administrator:innen:
Konfigurieren der Instanz

Hinweis:

Nach dem Anlegen einer Instanz ist auf dieser zundchst das Design , Boost” ausgewdhlt. Daher wurde dieses
Design (sofern nicht anders angefiihrt) auch fir die Screenshots und Anleitungen in vorliegenden Unterlagen
verwendet. Unter Umstanden sehen die vorgestellten Funktionalitdten auf lhrer Instanz unterschiedlich aus.

Wenn Sie das Design ,,Classic” verwenden, sind die Funktionalitdten, die laut diesem Handbuch Uber die jeweilige
,Navigationsleiste” erreichbar sind, Gber den Block ,Administration” und (zumeist) , Kurs-Administration”
aufrufbar.

Erste Schritte

Verwendung des Designs ,,Boost”

Ganz oben auf der Instanz finden Sie in der Navigationsleiste den Punkt ,, Website-Administration” (rot
markiert):

demo Startseite Dashboard Meine Kurse | Website-Administration A B 5 ~ Bearbeiten i

1-07 IT im Leben

Kurs Einstellungen Teilnehmer/innen Bewertungen Berichte Mehr ~

Wenn Sie auf diesen Punkt klicken, haben Sie Zugriff auf verschiedene Einstellungen, die die gesamte Instanz
betreffen (z. B. Userverwaltung, Spracheinstellungen, Sicherung ...).

Daneben befindet sich im oberen Bereich Ihrer Instanz eine Navigationsleiste, Gber die Sie fiir den jeweiligen
Kontext (Startseite der Instanz, Kurs, Aktivitat ...), in dem sie sich befinden, bestimmte Einstellungen vornehmen
kénnen (im Screenshot oben griin markiert). Hier kdnnen Sie beispielsweise Eckdaten (Name, Kursdauer ...) oder
Darstellungsoptionen des jeweiligen Kurses festlegen, Personen in den Kurs einschreiben oder Kurssicherungen
anlegen. Diese Navigationsleiste ist auch flr den:die jeweilige:n Trainer:in wichtig; die verfligbaren Optionen
unterscheiden sich jedoch abhangig davon, welche Rechte sie in dem jeweiligen Kontext besitzen.

7lil Education
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Verwendung des Designs ,,Classic”

Im Design ,,Classic” ist fur Sie als Administrator:in der Block ,Administration”
besonders wichtig. Er wird auf jeder Seite angezeigt und bietet die Moglichkeit,
kontextabhangig fur die gesamte Instanz, einen Kurs, eine Aktivitat ... Einstellungen
vorzunehmen.

Wenn Sie als Administrator:in beispielsweise eine Aktivitat gedffnet haben,
kénnen Sie Uber den Block ,Administration” direkt auf die Einstellungen der
Aktivitat selbst (Ziffer 1) zugreifen, aber auch die Kurseinstellungen (Ziffer 2) oder
Einstellungen, die sich auf lhre komplette Instanz beziehen (,Website-
Administration” - Ziffer 3), vornehmen. Zu Kurseinstellungen zahlen z. B. Eckdaten
wie die Kursdauer oder der Name, aber auch Darstellungsoptionen; unter
,Website-Administration“ finden Sie etwa die Userverwaltung oder
Spracheinstellungen.

Gestaltung der Instanz

Einstellungen der Startseite

g

_ HANDBUCH UND T1PPS E@
FUR DIE VERWENDUNG

Administration L

v Aufgaben-Administration o
& Einstellungen
@ Uberschreibungen
& Lokale Rollen zuweisen
a4 Rechte
24 Rechte priifen
Y Filter
#= Kompetenzaufteilung
L« Logdaten
© Sicherung
@ Wiederherstellen
@ Erweiterte Bewertung

@ Einreichungen
> Kurs-Administration e

> Website-Administration o

Als Administrator:in kdnnen Sie das Aussehen der Startseite Ihrer Instanz folgendermafRen anpassen:

Klicken Sie in der Navigation oben (bzw. im Block ,Administration”) auf den Punkt ,, Website-Administration”...

= Startseite Dashboard Meine Kurse |Website-Administration

Dashboard

Zeitleiste

TR =SUU 1 RS Y

.. und scrollen Sie dann nach unten zu ,,Startseite” — klicken Sie hier auf , Einstellungen der Startseite”.

Sicherheit TP-Blocker
Sicherheitseinstellungen
HTTP-Sicherheit
Systemnachrichten

Startseite | Einstellungen der Startseite I

Mobile App

Mobile Einstellungen

Mnndle-Ann-Ahnnnement

i Education
§: = Group

Die Bildungsagentur
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Die Einstellungen, die Sie hier vornehmen kénnen, sind u. a.

Die ,Kurzbezeichnung” (rote Markierung) erscheint
links von der Navigationsleiste und fungiert als Link
zurlick zur Startseite.

Name und Kurzbezeichnung lhrer Instanz ctartseite Dashboard  Mehr - A m 5.
Der ,,Name der Website” (tlirkise Markierung) wird auf
jeder Seite ganz oben Uber der Navigationsleiste -
. Demoinstanz
angezeigt.
Startseite Einstellungen Teilnehmer/innen Mehr v

Einstellungen der Startseite

Kursbereiche, eine Liste der Kurse, eine Kombination
aus beiden Listen, ein Fenster zur Kurssuche oder

Bei den Einstellungen im ersten Screenshot rechts
wurde unter ,Startseite” definiert, dass vor dem Login
keinerlei Informationen zu den Kursen auf lhrer Instanz
sichtbar sind.
Durch  die
,Eingeschriebene Kurse”

Auswahl der beiden Optionen

sowie ,Kurssuche” bei
»,Elemente auf der Startseite nach Anmeldung” wurde
festgelegt, dass die User nach dem Login die Kurse, in
denen sie als Trainer:in oder Teilnehmer:in
eingeschrieben sind, sowie ein Feld zur Kurssuche

angezeigt bekommen (siehe dazu den 2. Screenshot).

Name der Website ‘ Demoinstanz
Kurzbezeichnung ‘ demo
Startseite bzw. Startseite nach Anmeldung statseite [ o .
Hier kann ausgewahlt werden, welche Elemente vor Keine :
bzw. nach dem Login auf Ihrer Instanz zu sehen sein Keine N
SO”en. Keine s
Zur Auswahl stehen hier u. a. eine Liste der Keine :

Die ausgewahiten Elemente werden auf der Startseite angezeigt.

Startseite nach Eingeschriebene Kurse &

»Ankiindigungen®. Bei letzterem handelt es sich um | | A"medune - -
e urssuche 3

eine spezielle Art eines Forums, Uber das Sie e -
Mitteilungen an alle User senden kénnen. e .
Keine *

Zur Veranschaulichung: -

Keine s

Die ausgewahiten Elemente werden auf der Startseite angezeigt, wenn
Nutzer/innen angemeldet sind.

Demoinstanz

Meine Kurse

Tencher: Hannes Lerer

Hier konnen Sie die Lernplattiomm aus der Teilnehmer/innenperspektive kennen lemen und
[' bekommen dadurch einen Uberblick, wie Leminhalte mit Hilfe von eduACADEMY umgesetzt

[N werden kénnen

Fiir die Nutzung dieses Kurses ist ein Benutzerkonto auf dieser Seite erforderlich - Sie kannen sich
ier kostenlos registrieren

Teacher: Hannes Lehre

Alle Kurse
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Textabschnitt einbeziehen Demoinstanz
Wenn Sie zentral im oberen Bereich der Startseite
einen bearbeitbaren Bereich einfiigen méchten, in Herzlich willkommen auf unserer E-Learning-Umgebung!
dem Sie verschiedene Informationen bereitstellen
kénnen, setzen Sie hier ein Hakerl. e
o i ONLINE
Dies konnte dann z. B. wie rechts dargestellt aussehen. LEARNING

T

Kurse

¥ Miscellaneous

Weitere Informationen zur Einrichtung Ihrer Startseite finden Sie auch hier!

Dashboard fiir alle User anpassen

Wenn Sie mochten, kdnnen Sie festlegen, dass Benutzer:innen beim Aufruf der Instanz nicht auf der Startseite,
sondern direkt auf ihrem ,Dashboard" landen.

Beim Dashboard handelt es sich um eine individuell anpassbare Ubersichtsseite, auf der sich die User z. B. eine
Ubersicht der Kurse, in die sie eingeschrieben sind, anzeigen lassen kénnen. Auch die darin vorhandenen
Aktivitaten und die dazugehorigen Detailangaben konnten dargestellt werden. Unter ,, Website-Administration >
Darstellung > Navigation” im Dropdown-Men ,,Startseite flir Nutzer/innen” kdnnen Sie festlegen, welche Seite
die Benutzer:innen als Startseite lhrer Instanz angezeigt bekommen sollen.

Auch wenn die User selbst ihr Dashboard anpassen kdnnen, haben Sie als Administrator:in die Moglichkeit, ein
standardmaRiges Dashboard zu definieren und dort festzulegen, welche Inhalte wo auf dem Dashboard
angezeigt werden sollen: Dies funktioniert Gber , Website-Administration > Darstellung > Dashboard fur alle
anpassen”.

demo Startseite Dashboard Meine Kurse Website-Administration A B 5 ~

x

Dashboard fiir alle Nutzer/innen Gbx hi

Dashboard fiir alle anpassen [+ S |

[ + Block hinzufiigen o ‘ Meine Dateien L
> [ Neues Verzeichnis
Kursiibersicht * - PrasentationhSp
ale Meine Dateien verwalten...
Laufende ~ I Suchen “ Sortiert nach Kursname | Beschreibung ~ J
Admin-Kurs : Aktuelle Termine L
Grundlagen

Keine weiteren Termine
Zum Kalender ...

Bewegung macht SpaB!

Grundlagen " .
undieg Personen online L B

55% abgeschlossen
1 Person online (letzte 5 Minuten)
75 Technischer Support (&)

Zuletzt besuchte Kurse & i

L
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Zur Bearbeitung des Dashboards mussen sie in einem ersten Schritt erst den , Bearbeitungsmodus” mit Klick auf
den ,Schalter” (bzw. im Design ,Classic” den Button ,Blockbearbeitung einschalten”) rechts oben aktivieren
(siehe Markierung). Sie konnen anschlieBend per Klick auf ,Block hinzufligen” (Ziffer ,, 1“) Blocke auf der Seite
hinzuftigen bzw. diese dann Gber den Pfeil bzw. das Dreipunkt-Men (Ziffer ,,2“) verschieben oder bearbeiten.

Fiir das Dashboard empfiehlt sich v. a. der Einsatz der Blocke ,Kursiibersicht” sowie ,,Zuletzt besuchte Kurse”, da
diese dann einen unkomplizierten Zugriff auf die Kurse ermdoglichen, die von den Benutzer:innen wirklich aktuell
bendtigt werden.

Per Klick auf ,Dashboard fur alle Nutzer/innen Gbernehmen” werden die von lhnen definierten Einstellungen
gespeichert und auf die Dashboards all Ihrer User angewendet.

N&here Informationen zum Thema Dashboard finden Sie auch hier.

»Meine Kurse”

Die Seite ,Meine Kurse” bietet fiir die Benutzer:innen lhrer Instanz eine kompakte Ubersicht tiber die Kurse, in
die sie als Trainer:innen oder Teilnehmer:innen eingeschrieben sind. Die Ubersicht kann nach verschiedenen
Kriterien gefiltert oder durchsucht werden und ermdoglicht einen raschen Zugriff auf die Lerninhalte:

Meine Kurse
Kursiibersicht

m‘ ceticl

v Alle

Laufende

Sortiert nach Kursname v Kachel v

" s et
Kunftige
Beispielkurs Demo-Kurs

Kursunterbereich Test Grundlagen

Vergangene
Favoriten

Aus Ansicht entfernte

Als Administrator:in kénnen Sie entweder unter ,Website-Administration > Darstellung > Navigation” im
Dropdown-Men ,Startseite fir Nutzer/innen“ die Seite ,,Meine Kurse” als Startseite fur die Benutzer:innen Ihrer
Instanz festlegen oder aber auch — wie oben erwéhnt — den Block , Kurstibersicht” auf dem Dashboard fir alle
Nutzer/innen platzieren.

Blocke in verschiedenen Kontexten

Das Aussehen der einzelnen Seiten lhrer Instanz kdnnen Sie durch direktes Aus- und Einblenden von Blocken
andern. Aktivieren Sie dazu, wenn Sie sich auf der jeweiligen Seite befinden, rechts oben den ,Bearbeiten”-
Modus (entweder per Klick auf den ,,Schalter” oder den entsprechenden Button) und wahlen Sie anschlieRend
unter ,,Block hinzufligen” (zumeist in der rechten oder linken Spalte zu finden) den gewlinschten Block aus.

Ein Uberblick zum Thema Blécke findet sich hier — folgende Blécke méchten wir an dieser Stelle besonders
erwahnen:

e Hauptmenii: Dieser Block ist nur auf der Startseite verfiigbar und ist dafiir gedacht, den Besucher:innen
lhrer Instanz direkt nach dem Einstieg erste Informationen zu lhrer Instanz zu liefern. Dafiir konnen -
wie in einem klassischen Kurs - in dem Block eine Vielzahl von Aktivitdten bzw. Arbeitsmaterialien
angelegt werden, auf die dann einfach zugegriffen werden kann.

e Kursiibersicht: Dieser Block liefert im Dashboard einen raschen Uberblick (iber die Kurse, in denen man
als Teilnehmer:in oder Trainer:in eingeschrieben ist.
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e Kalender: Der Kalender dient zur Darstellung von Terminen auf der Instanz - es kann sich hier z. B. um
Abgabetermine ebenso wie um personliche Termine handeln. Ndhere Informationen finden sich auch
hier.

e Textblock: Dieser Block kann dazu genutzt werden, um Inhalte (z. B. Text oder Bilder) in einem Block auf
der Instanz darzustellen.

Die meisten Blocke tauchen, sobald sie einmal hinzugefiigt wurden, nicht mehr in der Liste der verfligbaren
Blocke auf. Eine Ausnahme bildet hierbei z. B. der Textblock. Daneben gibt es auch Blocke, die nur bei gewissen

Designs oder in gewissen Kontexten verfugbar sind.

Die einzelnen Blocke kdnnen Sie nach dem Hinzufiigen mit Hilfe der Symbole im Block

verschieben (Pfeil) bzw. iiber das Dreipunkt-Menii konfigurieren, l6schen, Rechte | Kalender #d
. & ‘Kalender'
andern usw. ~  konfigurieren

So ® ‘'Kalender verbergen
Sie kdnnen Blocke nicht nur auf einer einzigen Seite anzeigen lassen, sondern diese 24 Rechte

6 2a Rechte prifen

auf Wunsch auch , durchschalten”, sodass ein Block z. B. auf jeder Seite der Instanz,
W 'Kalender loschen

eines Kursbereichs oder eines Kurses zu sehen ist.

Aktivieren Sie hierfir den ,Bearbeiten“-Modus und klicken Sie bei dem gewiinschten Block auf das Dreipunkt-
Meni und auf den Punkt , konfigurieren®.

Wahlen Sie bei ,Seitenkontext” im Dropdown-Menii die gewiinschte Option aus:
Block ‘Kalender' konfigurieren

~ Blockplatzierung

Stanseite

Nosmale Blockplatzierung ']

Seitenkontext [}

Standardbereich [}

Standardgemichiung o

v Blockplatzierung auf dieser Seite

sichtbar

) bbrechen

Hinweis:
e Die Auswahl der Option , Uberall auf der Website anzeigen” ist nur fiir die Blécke méglich, die Sie auf
der Startseite lhrer Instanz platziert haben.
e Wenn ein Block auf allen Seiten eines Kursbereichs angezeigt werden soll, muss dieser erst auf der Seite
des jeweiligen Kursbereichs platziert und anschlieRend wie oben beschrieben konfiguriert werden.
Gleiches gilt fur Blocke, die auf jeder Seite eines Kurses angezeigt werden sollen.

Nahere Informationen rund um Blocke sind auch hier sowie im Kapitel ,,Arten von Inhalten in einem Kurs” zu

finden.
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Das Design lhrer Instanz konnen Sie iber den Menlipunkt , Website-Administration > Darstellung > Designs”

anpassen.

Sie sehen hier eine Ubersicht der auf lhrer Instanz
installierten Designs - auf Moodle auch Themes
genannt. Wir mochten hier besonders auf das Theme
,Maker”“ hinweisen, durch das Sie lhrer Instanz ein
modernes und

ansprechendes  Erscheinungsbild

verleihen kdnnen.

Klicken Sie zum Andern des Designs lhrer Instanz
einfach auf den Button ,Design auswdhlen”. Wenn
gewdinscht, konnen Sie per Klick auf das Zahnrad unter
auch individuelle

den jeweiligen  Optionen

Anpassungen an das Design vornehmen - die

Moglichkeiten unterscheiden sich hier je nach Theme.

Unter ,Website-Administration > Darstellung >

Erweiterte Designeinstellungen” kénnen Sie weiters die
Rechte zur Auswahl eigener Kurs- und Kategoriedesigns
sowie  Benutzer:innen ihre

vergeben eigene

Designauswahl ermoglichen.

Aligemein  Nutzerfinnen  Kurse  Bewertungen  Plugins arstellung

Designs
Design-Cache loschen
- - T
o ‘ |
’ Wiggy 4
Boost o[&] Akademi © ©  Adaptable o
" x — :
0 Y e D
W :
a
Boost Office365 [} BoostUnion © = @ Classic [ -
Teams o
1 -
~ L
~ o
. J "
Maker 0= Moove o=

Wir empfehlen hier auf jeden Fall, das Hakerl bei ,,Minimierung von Blocken erlauben” zu entfernen. So wird

vermieden, dass Kursteilnehmer:innen womaglich Blécke ausblenden, die fiir den Unterricht wichtig sind.

N&here Informationen zu diesem Thema finden Sie auch hier.

Logo

Moodle bietet bei vielen Designs die Moglichkeit, Logos einzubetten, um die Instanz auch in dieser Hinsicht

individuell zu gestalten.

Dies funktioniert tGber , Website-Administration > Darstellung > Logos”. Hier konnen drei verschiedene Logos

hochgeladen werden:

e Logo: wird auf der Startseite tUiber der Login-Maske angezeigt

e Kleines Logo: wird links oben in der Kopfzeile der Instanz angezeigt

e  Favicon: wird im Browser-Tab neben dem Seitentitel angezeigt

Website registrieren

Moglicherweise féllt lhnen im Bereich ,Website-Administration” auf lhrer Instanz folgender Hinweis auf:
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Wetate Admmanusts ot .

Verpassen Sie keine wichtigen Updates und Sicherheitswarnungen.  Website registrieren

Die Registrierung lhrer Instanz ist nicht verpflichtend und hat nichts mit Lernplattform OO an sich zu tun —
vielmehr handelt es sich um eine Registrierung beim Moodle HQ. Damit flieBt Ihre Instanz u. a. in die offizielle
Moodle-Statistik mit ein.

Moodle selbst schreibt dazu: ,Durch Ihre Registrierung erhalten wir einen besseren Uberblick, wie Moodle
weltweit genutzt wird. Das hilft uns bei der Entscheidung liber neue Funktionalitdten und Plugins. ... Wir nutzen
die gesammelten anonymen Daten nur, um die Statistiken der weltweiten Community zu veroffentlichen. ... Die
Registrierung ist optional, aber wir mochten nicht, dass Sie wichtige Benachrichtigungen Gber
Sicherheitswarnungen oder Aktualisierungen verpassen.” (Quelle und weitere Informationen zu diesem Thema)

Fiir Administrator:innen: User und Registrierung

Neue Benutzer:innen handisch anlegen

Das handische Anlegen von neuen Benutzer:innen unter ,Website-Administration > Nutzer/innen >
Nutzerkonten > Nutzer/in anlegen” ist die wahrscheinlich

aufwendigste Moglichkeit, neue Userkonten zu erstellen. e

Anmeldename
Authentifizierung

Fillen Sie die entsprechenden Felder im Formular aus, um

Gespernes Nutzerkonto

einen neuen User anzulegen. Teilen Sie ihm/ihr Kenmwcrt rzugen und uzari

benachrichtigen

anschlieBend die Zugangsdaten mit.

Neues Kennwort () Ankickon zur Toxtaingabe £ Q

Informationen hierzu sind auch hier zu finden.

Kenawortinderung fordem (2

Vorname *

Nachname *

Nutzer:innen Uber eine Liste hochladen

Wenn Sie eine groBe Anzahl von Nutzer:innen anlegen mochten, empfiehlt sich der Einsatz einer CSV-Datei.
Legen Sie dazu am besten ein Tabellendokument mit folgender Struktur an:

username password firstname lastname email
muma changeme Max Mustermann | mmustermann@edubhi.at
mahe changeme Helene Mayer hmayer@beispiel.com

Eine entsprechende Vorlage erhalten Sie gerne {iber unseren Support!

In der ersten Zeile der Liste legen Sie die Datenfelder fest. Die oben angefiihrten Spalten mit den exakten
Spalteniberschriften sind unbedingt zu empfehlen. Die Reihenfolge der Spalten kénnen Sie selber bestimmen.
Optional kdnnen Sie weitere Datenfelder wie z. B. coursel, course2, etc. einfligen, wo Sie beispielsweise die
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Kurzbezeichnung von vorhandenen Kursen eintragen kdnnen, um die Benutzer:innen dann automatisch in die
Kurse einzuschreiben.

Bitte beachten Sie Folgendes:

e Die Spalte ,username” darf nur Kleinbuchstaben, Zahlen, Bindestriche, Unterstriche, Punkte oder das
@-Zeichen enthalten. Sonstige Sonderzeichen sowie &, 6, G und B werden entfernt. Diese Einschrankung
koénnen Sie umgehen, indem Sie unter ,, Website-Administration > Sicherheit > Sicherheitseinstellungen”
bei ,Sonderzeichen in Anmeldenamen® ein entsprechendes Hakerl setzen.

Beachten Sie aber, dass es hier dann unter Umstanden zu Problemen kommen kann!

e Eingaben im Feld, E-Mail” sollen in der Form name@email.com erfolgen. Auch hierbei sind keine
Umlaute erlaubt. Vergessen die Benutzer:innen ihr Passwort, wird ihnen dieses an die dort angegebene
E-Mail-Adresse geschickt.

Falls das nicht funktioniert, missen Sie die entsprechenden Daten als Administrator:in manuell
anpassen.

e Wenn Sie im Feld , password” den Text ,,changeme” (ohne Anfiihrungszeichen) eingeben, kdnnen die
User fir den ersten Login das Passwort ,changeme” verwenden und werden dann automatisch
aufgefordert, das Passwort zu andern.

Sie gelangen uber ,Website-Administration > Nutzer/innen > Nutzerkonten > Nutzerliste hochladen” zur
Eingabemaske, um die von lhnen erstellte Userliste hochladen zu kdnnen. Normalerweise miissen Sie keine
Anderungen an den Einstellungen auf dieser Seite vornehmen; wir empfehlen lediglich, bei ,Encoding”
,Windows 1252“ auszuwahlen, damit Umlaute und B erhalten bleiben.

Auf der darauffolgenden Webseite konnen Sie festlegen, ob die Daten von bereits vorhandenen Benutzer:innen
aktualisiert werden sollen. Wahlen Sie dazu im Dropdown-Menu bei ,,Upload Typ“ die entsprechende Option
aus, und bestatigen Sie anschliefend den Dateiupload.

Nahere Informationen finden Sie auch hier.

Selbstregistrierung der User erlauben

Sie kdnnen unter ,,Website-Administration > Plugins >

Authentifizierung >  Ubersicht”  verschiedene Algemen e e gt g DaEelng S geie s
Einstellungen rund um die | Ubersicht
Registrierung/Authentifizierung von Benutzer:innen Verfligbare Plugins zur Authentifizienung
vornehmen. Wenn Sie den Usern die Moglichkeit Enstelungen
Name Aktivieren a priifen Deinstallieren

geben mdochten, selbst ein Konto anzulegen, stellen Sie ———
erst sicher, dass das ,Auge” neben ,E-Mail basierte Kein Logi o
Selbstregistrierung” nicht durchgestrichen erscheint. Ejid b :

Selbstregistrierung

Falls dies der Fall ist, klicken Sie es einfach an.

Scrollen Sie dann nach unten und klicken Sie im unteren Bereich der Seite im Bereich ,,Grundeinstellungen” auf
das Dropdown-Meni neben ,Selbstregistrierung”. Wahlen Sie , E-Mail basierte Selbstregistrierung” aus und
bestatigen Sie mit Klick auf ,Anderungen sichern®.

v
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®

Wahlen Sie die Authentifizierungsverfahren aus, die Sie benutzen machten, und ordnen Sie diese in eine Reihenfolge der Nutzung.
Hinweis: Bei einer spateren Deaktivierung von Authentifizierungsverfahren kann es passieren, dass Nutzer/innen mit dem deaktivierten
Verfahren keinen Zugang mehr erhalten. Prufen Sie dies sorgfaltig

Alle Anderungen in der obigen Tabelle wurden automatisch gespeichert.

Grundeinstellungen

Selbstregistrienung | £yl basierte Selbstregistrierung ¢ | Standard: Deaktiviere

Wenn die Selbstregistrierung (2.8, 'E-Mail basiert) aktiviert ist, kinnen sich alle Personen selbst
registrieren und ein Nutzerkonto anlegen. Auf diese Weise konnten aber auch Spammer ein
Nutzerkonto erhalten und Eintrage in Foren, Blogs oder Profilen missbrauchen. Um dieses Risiko zu
vermeiden, konnen Sie die Selbstregistrierung ausschatten oder auf bestimmte E-Mail-Domains (28
meinefirma.de) beschranken.

lhre Benutzer:innen kénnen nun, sofern sie noch Uber keine Zugangsdaten verfiigen, auf der Login-Seite lber die
Schaltflache ,Neues Konto anlegen” selbststandig ein Benutzer:innenkonto auf lhrer Instanz anlegen. Dabei
muss eine glltige E-Mail-Adresse angegeben werden, da an diese ein Bestdtigungsmail geschickt wird. Dieses E-
Mail enthélt einen Link auf eine Seite, wo die Nutzer:innen ihren Zugang bestatigen missen. Die E-Mail-basierte
Selbstregistrierung ist hier noch etwas naher beschrieben.

Um Spam-Registrierungen vorzubeugen, kdnnen Sie unter ,, Website-Administration > Plugins > Authentifizierung
> E-Mail basierte Selbstregistrierung” einen ,ReCaptcha“ einschalten. Diese Einstellung flgt dem
Anmeldeformular zur Selbstregistrierung ein Kontrollelement hinzu, um die Instanz wirksam gegen Spam zu
schiitzen. Details hierzu finden sich hier.

Authentifizierung Gber OAuth2

lhre Lernplattform bietet auch die Méglichkeit, z. B. bestehende 0365-Konten fiir die Authentifizierung der User
zu verwenden. Dazu mussen Sie als Administrator:in einen ,0Auth2 Service” erstellen — das funktioniert tiber
,Website-Administration > Server > OAuth 2 Services”.

Ndhere Informationen finden Sie hier; Artikel zu den je nach Provider unterschiedlichen Einstellungen sind hier
verlinkt.

Hinweis: Wir empfehlen lhnen als Administrator:in unbedingt, nicht (nur) mit einem {ber OAuth2
authentifizierten Konto zu arbeiten, sondern immer auch einen lokalen Admin-User auf Ihrer Instanz zu behalten!

Weitere Authentifizierungsmethoden

Neben den kurz beschriebenen Authentifizierungsméglichkeiten bietet Ihre Lernplattform OO-Instanz noch eine
groRe Bandbreite von weiteren Anmeldemethoden wie z. B. Shibboleth, LDAP und viele andere mehr.

Einen Uberblick hierzu gibt es an dieser Stelle zu finden.
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Multi-Faktor-Authentifizierung

Mit der Multi-Faktor-Authentifizierung (MFA) kénnen Sie beim Login zusatzlich zum Benutzernamen und
Passwort einen weiteren Sicherheitsfaktor abfragen. Dadurch wird der Zugriff auf die Instanz besser geschitzt,
weil Angreifer mehrere Dinge gleichzeitig kennen oder besitzen missten.

Die MFA ldsst sich unter ,,Website-Administration > Plugins > Dienstprogramme > Multi-Faktor-Authentifizierung
verwalten” aktivieren. Setzen Sie dort einfach ein Hakerl bei ,MFA Plugin aktiviert”.

Sie kénnen verschiedene Faktoren verwenden (z. B. App-Code, E-Mail-Code, Sicherheitsschliissel) und diese
unterschiedlich gewichten. Damit konnen Sie flexibel einstellen, wie sich Nutzer:innen anmelden missen.

Ndhere Informationen und Tipps fiir die Verwendung sind hier abrufbar.

Nutzerprofile

Jede:r Nutzer:in verflgt Uber eine eigene Nutzerprofilseite, die per Klick auf das e 5
|ll

Profilbild rechts oben und anschliefend den Link ,,Profil“ im Nutzermeni aufgerufen

Profil
werden kann.

Bewertungen
Kalender
Administrator:innen kénnen die Profile anderer User aufrufen, indem sie einfach in Mitteilungen

der Liste der Nutzer:innen auf den entsprechenden Namen klicken. Meine Dateien

Berichte

Auf dieser Seite finden sich verschiedene Links, die beispielsweise die Bearbeitung des Einstellungen

Profils erméglichen oder Zugriff auf verschiedene nutzer:innenspezifische Berichte (z. | ™™ '

B. Logdaten, Bewertungen) ermdoglichen. togout

Fir eine:n Administrator:in kdnnte eine Profilseite beispielsweise so aussehen:
Mutzer/innen / Hubert Lehrer / Profil anzeigen Standard wiederherstellen
Hubert Lehrer ® witsiung 8 7u kontakeen hinaufugen

Mehr Details

E-Mail-Adresse

Zeitzone
Europe/Berlin

Administratio

Einstellungen

Anmelden als

Login-Aktivitat
Erster Zugriff auf die Website

Mittwoch, 12 Juli 2023. 09:39 (1 Jahr 354 Tage)
Letxter Zugriff suf die Website

Freitag. 1. Jul 2025, 0850 (5 Minuten 45
Sekunden)

Letzte IP-Adresse

Administrator:innen kdnnen neben den standardmaRig vorhandenen Profilfeldern noch zusatzliche Profilfelder
anlegen und diese in Kategorien zusammenfassen. Hierbei kann es sich um Textfelder, Datumsangaben,
Checkboxen, Dropdown-Menus usw. handeln, die entweder optional oder verpflichtend zu befillen sind.
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N&here Informationen dazu sind hier zusammengefasst.

Andern eines Userprofils oder Kennworts

Grundsatzlich kénnen User Daten in ihrem eigenen Profil anpassen, indem sie es wie oben beschrieben aufrufen
und anschliefend auf den Link ,,Profil bearbeiten” klicken:

Nutzerfinnen / Hubert Lehrer / Profil anzeigen Standard wiederherstellen

Hubert Lehrer ® witeivng 88 zu Kontsken hinzufugen

Mehr Details Berichte
E-Mail-Adresse Alle Logdaten

Zusammentassung

Zeitzone

Furnna/farin

AnschlieRend konnen in der Eingabemaske die gewlinschten Anpassungen vorgenommen werden. Im Falle einer
Authentifizierung liber externe Quellen wie OAuth2 oder LDAP erfolgt die Anderung der Daten iiber den
jeweiligen Provider.

Als Administrator:in konnen Sie die Daten in einem lokalen Userkonto &ndern, indem auf ,Website-
Administration > Nutzer/innen > Nutzerkonten > Nutzerliste anzeigen” aufrufen. Per Klick auf den Button ,,Filter”
gelangen Sie zu einer Suchmaske und kénnen hier Ihre Nutzer:innenliste nach verschiedenen Kriterien filtern.
Bestatigen Sie lhre Auswahl mit Klick auf ,,Anwenden”.

- Filter (1)

Vorname / Nachname E-Mail Adresse

Tabeliendaten herunterladen aks| Komma s

Fiir ausgewshite Nutzer/innen

Suchen Sie das entsprechende Nutzer:innenkonto und klicken Sie auf das Dreipunkt-Menl, um das Profil
entsprechend bearbeiten zu kénnen:

O Vorname / Nachname E-Mail-Adresse Letzter Zugriff

Hubert Lehrer 1 Stunde 7 Minuten D

# Bearbeiten
W& Nutzerkonto sperren
[}

Léschen

Uber , Website-Administration > Nutzer/innen > Nutzerkonten > Nutzerverwaltung (Bulk)“ kénnen Sie fiir eine
groBere Anzahl von Userkonten verschiedene Aktionen vornehmen. So kénnen Sie sie beispielsweise zur
Passwortdanderung auffordern, ihnen eine Mitteilung senden, die Benutzer:innen I6schen oder sie bestatigen.

Achtung: Der User ,Technischer Support” sollte nie verandert werden! Er wird von unserem Support-Team
verwendet und ist notwendig, wenn Sie nicht mehr weiterwissen und Hilfe von aulRen bendtigen.
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Weitere Informationen zum Bearbeiten von Nutzerprofilen gibt es hier zu finden.

Globale Gruppen

Mit Hilfe so genannter ,,Globaler Gruppen” kénnen Sie sehr unkompliziert die User in lhrer Instanz gesammelt
verwalten und beispielsweise eine ganze Gruppe von Personen mit wenigen Mausklicks in einen Kurs

einschreiben.

Das Anlegen globaler Gruppen funktioniert Uber , Website-Administration > Nutzer/innen > Nutzerkonten >
Globale Gruppen”. Klicken Sie hier einfach auf den Reiter ,,Neue globale Gruppe anlegen” und fiillen Sie das

Formular aus.
Um Nutzer:innen einer bestehenden Gruppe hinzuzufiigen, klicken Sie auf das Dreipunkt-Meni rechts und auf

L,Zuweisen”:

Systemweite globale Gruppen

Systemweite globale Gruppen  Alle globalen Gruppen  Neue globale Gruppe anlegen  Globale Gruppen hochiaden

¥ Filter
[ Name 12 Globale Gruppen-1D Beschreibung GréBe Quelle
[ Gruppe 1.4 Gruppe 1 #* 10 Manuell erzeugt
[ Gruppe 2 # Gruppe 2 # 41 Manuell ® Verbergen

# Bearbeiten
B Loschen

Auswahl laschen
= Zowesen

Sie gelangen zu einer Ubersicht der in der Instanz registrierten User und kénnen diese der globalen Gruppe

hinzufiigen.

Mitglieder der globalen Gruppe "1a’

Wenn Nutzer/innen aus einer globalen Gruppe entfernt werden, konnten diese i di Kursen abgemeldet *
werden. Dabei werden 3 und weitere ationen in den
betraffenen Kursen gelascht,

Aktuelle N Maghche Nutzer/innen

Magliche Nutzer/innen (74)
£k .

ndrea A

= Hinzufigen

Entfernen =

Suehen

Suchoptionen »

Zuraick zu globaken Gruppen

Mochten Sie mehrere globale Gruppen auf einmal [6schen, ist dies moglich, indem Sie diese per Hakerl markieren
und im Anschluss auf den Button ,Auswahl l|6schen“ klicken. Damit wird lediglich die jeweilige
Gruppe(nzugehorigkeit) geldscht; die Konten der Benutzer:innen, die der jeweiligen Gruppe angehdren, sind von

der Loschung nicht betroffen!

Weitere Informationen zur Einschreibung mithilfe globaler Gruppen sind im Kapitel ,Rund um die
Kursteilnehmer:innen” in diesem Handbuch zusammengefasst; die offizielle Moodle-Dokumentation zum

Thema finden Sie hier.

@h‘f‘l Education
T Group Moodle 4.5 | Stand 2025 21

Die Bildungsagentur


https://docs.moodle.org/405/de/Nutzerprofil_aktualisieren
https://docs.moodle.org/405/de/Globale_Gruppen

Lernplattform 00 _ HANDBUCH UND T1ps E@
FUR DIE VERWENDUNG

Mitteilungen & Systemnachrichten

In lhrer Instanz haben User die Mdoglichkeit, sich gegenseitig personliche

Mitteilungen zu senden. Dies ist kann von lhnen als Administrator:in unter
,Website-Administration > Zusatzoptionen” global deaktiviert werden. Uber neue ! ﬂ & ~
Nachrichten werden die jeweiligen Benutzer:innen standardmaRig informiert,

indem auf der Instanz rechts oben neben der Sprechblase eine entsprechende

Ziffer zu sehen ist.

Durch Klick auf die Sprechblase kann die jeweilige Nachricht ge6ffnet und beantwortet werden. Der:Die
Administrator:in kann Uber , Website-Einstellungen > Mittelungen > Mitteilungseinstellungen” festlegen, wem
die Benutzer:innen Mitteilungen senden kdnnen sollen; die Benutzer:innen selbst kénnen per Klick auf ihren
Benutzernamen rechts oben, den Menipunkt ,Mitteilungen” und das dort zu findende Zahnradchen definieren,
von wem sie Mitteilungen erhalten kénnen sollen:

Suches Q E Einstellungen

& Kontakte  Datenschutz

Welche Personen sollen Ihnen persénliche
Mitteilungen senden kénnen?

« Favoriten (1)

Technischer ... > Nur meine Kontakte
.

Kontakte und aus meinen Kursen

* Gruppe (0) o Alle auf der Website

T
¥ Personlich (%) Systemnachrichten

@ cvail

Allgemein

@ ) tingabetaste zum Senden tippen

Nahere Informationen zum Thema Mitteilungen finden Sie auch hier.

Neben Mitteilungen werden von lhrer Instanz auch Systemnachrichten versandt. Hierbei handelt es sich um
Benachrichtigungen zu Ereignissen auf lhrer Plattform wie z. B. neue Forenbeitrdge, Bewertungen,
Kalendererinnerungen usw. Die Benutzer:innen sehen rechts oben neben ihrem Profilbild auf der Instanz durch
die Ziffer beim Glocken-Symbol, ob neue Systemnachrichten vorliegen (siehe Screenshot oben in diesem Kapitel).

Jede:r Benutzer:in kann individuell festlegen, ob die Benachrichtigung zu Systemnachrichten per E-Mail oder nur
Uber die Weboberflache erfolgen soll. Dies lasst sich einstellen, indem sie rechts oben beim Benutzernamen auf
,Einstellungen” klicken und anschliefend den Punkt ,Systemnachrichten” aufrufen:

Stortcite Dashboard bicine Kurse LY RS

& Alexandra Schiilerin ™ e

Einstellungen

Nutzerkonto Repositories Blogs

In der darauffolgenden Ubersicht kénnen Sie die gewiinschten Einstellungen treffen.
Nahere Informationen finden Sie auch hier.
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Einschreibemethoden verwalten
Es gibt verschiedene Moglichkeiten, User in einen Kurs einzuschreiben. Diese missen grundsétzlich erst vom

Administrator bzw. der Administratorin einmalig systemweit aktiviert werden, bevor sie in den jeweiligen Kursen
zum Einsatz kommen kénnen.

Einen Uberblick Giber diese finden Sie hier bzw. hier.

Die systemseitige Aktivierung der Einschreibemethoden erfolgt ber ,Website-Einstellungen > Plugins >
Einschreibung > Ubersicht“. Wenn das Auge neben der jeweiligen Methode durchgestrichen erscheint (wie im
Screenshot bei ,Automatische Einschreibung®), ist diese deaktiviert. Durch Klick auf das Auge kénnen Sie die
Methode systemweit aktivieren. Uber den Link ,Einstellungen” kdnnen Sie jeweils noch einige
Grundeinstellungen treffen, die dann systemweit greifen.

Ubersicht

Verfiigbare Einschreibeplugins

Einstellungen

Name Einschreibungen  Version Aktivieren  Aufwdrts/Abwérts  Einstellungen  priifen Deinstallieren
Manuelle Einschreibung 156 /124 2024100700 @& + Einstellungen
Selbsteinschreibung 157 /2 2024100700 @ T 4 Einstellungen Deinstallieren
Globale Gruppe 2/26 2024100700 @ L Einstellungen Deinstallieren
Gastzugang 142 /0 2024100700 @ + Einstellungen Deinstallieren
Automatische Einschreibung 0/0 2025031400 W Einstellungen Deinstallieren

Gastzugang erlauben

Fiir gewohnlich ist es notwendig, sich einzuloggen, um auf die Inhalte auf einer Instanz zuzugreifen — Sie kdnnen
dies aber auch Usern in der Gast-Rolle (also ohne Login) ermdglichen.

Nehmen Sie dazu als Administrator:in folgende Einstellungen vor:

‘,.Qh‘f‘l Education
N Group Moodle 4.5 | Stand 2025 23

Die Bildungsagentur


https://docs.moodle.org/405/de/Einschreibung
https://docs.moodle.org/405/de/Einschreibemethoden

L B

Lernplatiform 00 HANDBUCH UND T1pps EE\

FUR DIE VERWENDUNG

Gastzugang beim Login aktivieren

Aktivieren Sie unter , Website-Administration > Plugins > Authentifizierung > Ubersicht” den ,Login fiir Gaste”
Uber das entsprechende Dropdown-Men (Hinweis: Auf der Seite nach unten scrollen!), um in der Login-Maske
den Button ,Anmelden als Gast” anzuzeigen.

Login fiir Gaste | Anzeigen * | Standard: Anzeigen
guestloginbutton -/

Sie konnen auf der Anmeldeseite die Taste zum Gast-Login anzeigen oder verbergen. Wenn die Taste
verborgen ist, ist ein Gast-Login fir die Website nicht erlaubt.

Falls Sie mochten, dass die User lhrer Seite automatisch Gastzugang auf lhre Instanz haben, ohne den Button

klicken zu mussen, kénnen Sie unter ,, Website-Administration > Nutzer/innen > Rechte > Nutzereigenschaften”
das entsprechende Hakerl neben , Gaste automatisch einloggen” setzen.

Gastzugang als Einschreibemethode definieren

Stellen Sie sicher, dass unter ,Website-Administration > Plugins > Einschreibung > Ubersicht” das Auge neben
,Gastzugang” nicht durchgestrichen ist (siehe dazu auch die Ausfiihrungen oben). Bei Klick auf , Einstellungen”
haben Sie u.a. folgende Optionen:

e  Plugin zu neuen Kursen hinzuftigen: Wenn Sie hier ein Hakerl setzen, wird in jedem neu angelegten Kurs
die Einschreibemethode , Gast” automatisch hinzugefiigt — sie ist aber noch ausgeblendet und muss
(wenn gewlinscht) von dem:der jeweiligen Trainer:in aktiviert werden.

e  Gastzugang erlauben: Wenn Sie hier ,Ja“ auswahlen, ist jeder neu angelegte Kurs standardmaRig fir
Gaste zugdnglich. Dies kann von dem:der jeweiligen Trainer:in auf Wunsch deaktiviert werden.

e Zudem konnen Sie noch festlegen, ob fiir die Nutzung eines Gastzugangs in einem Kurs zwingend ein
Kennwort verwendet werden muss.

Informationen dazu, wie ein:e Trainer:in den Gastzugriff in einem Kurs erlauben kann, finden Sie im Kapitel ,, Fiir
Trainer:innen: Rund um die Kursteilnehmer:innen®. Weitere Informationen zum Gastzugang im Allgemeinen sind
hier zusammengefasst.

Zugriff auf Startseite und Kursiibersicht beschranken

StandardmaRig werden die Startseite sowie

die Ubersicht der Kurse auf lhrer Instanz | Demoinstanz e B
(Jedoch nicht dle Kurse selbst) angezelgtl Allgemein Nutzer/innen Kurse Bewertungen Plugins Darstellung Server Berichte Entwickiung
ohne dass ein Login notwendig ist. Wenn Sie Sicherheitseinstellungen

mochten, dass auch diese Inhalte Anmeldenamen sehliZen 3 sandarc Jo

a USSCh”e@“Ch fu r a ngemeldete aD:‘egs;g::iil:r\zg:‘iesl dass keine Hinweise fr vergessene Anmeldenamen und Kennworter
Benutzer:innen zuganglich sind, aktivieren Anmeung notwenda B Standarc Nein

Normalerweise konnen Startseite und Kursubersicht (nicht jedoch die Kurse) angezeigt werden,
ohne dass man angemeldet ist. Aktivieren Sie diese Option, wenn eine Anmeldung zwingend sein
soll, um irgendetwas auf der Website sehen zu konnen

Sie unter ,Website-Administration >
Allgemein > Sicherheit >
Sicherheitseinstellungen” den Punkt ,,Anmeldung notwendig”.
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Fiir Administrator:innen:
Kursbereiche und Kurse anlegen und konfigurieren

Auf lhrer Instanz kénnen sowohl Kurse als auch Kursbereiche erstellt werden. Kursbereiche dienen dazu, die
Kurse Ubersichtlich zu organisieren bzw. grundlegende Einstellungen wie Berechtigungen fiir mehrere Kurse
gleichzeitig festzulegen. So ist es beispielsweise sinnvoll, fiir jede Lehrveranstaltung oder jede Klasse einen
Kursbereich anzulegen. In diesem Kursbereich kénnen beliebig viele Kurse erstellt werden, in denen dann die
Lerninhalte zu finden sind.

StandardméRig haben neben Administrator:innen die Rollen ,Manager/in“ und , Kursersteller/in“ die Rechte
dazu, einen Kurs zu erstellen bzw. einen Kursbereich anzulegen. Dies funktioniert Gber , Website-Administration
> Kurse > Kurse und Kursbereiche verwalten” bzw. iber ,Meine Kurse” in der Navigationsleiste ganz oben und
den Button ,Kurse verwalten”:

Kursbereiche und Kurse bearbeiten
Kursbereiche Grundlagen
[Fp——— RRRTRRRRRRN Kurse new odnen ~ Prc Sene 20 «
® & () ok roBe
t * e g i Sl PN R

oW bW

Auspevahine £ Vershieben

Links finden Sie die Kursbereiche, rechts die Kurse, die sich im jeweiligen Kursbereich befinden.

Anlegen eines Kursbereichs

Kursbereich anlegen

Klicken Sie zum Anlegen eines neuen Kursbereichs einfach links
Unemecraneter Kurshessich @ (2 Grundiagen

auf den entsprechenden Button, um die Eingabemaske

L

aufzurufen. Beim Anlegen eines Kursbereichs missen Sie fir ihn

Name des Kursbereichs [ ]
Oberste Ebene (1op level)

einerseits einen Namen vergeben und andererseits auswahlen, |

Beschreibung Kurssamm g

Kussamrng Kusmeeen e g . .
[ R

ob dieser einem anderen Kursbereich untergeordnet sein soll
oder in der Hierarchie ganz oben stehen soll. Dazu finden Sie in
der Maske zur Anlage eines Kursbereichs ein entsprechendes
Dropdown-Menii:

Die Bearbeitung eines Kursbereichs ist im Nachhinein immer | .. o
Gber das Dreipunkt-Menl neben dem Namen des Kursbereichs
moglich (siehe dazu den Screenshot weiter oben).
Ndheres zum Thema Kursbereich finden Sie hier.
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Anlegen eines Kurses

Klicken Sie zum Anlegen eines Kurses links zunadchst auf den jeweiligen Kursbereich und anschliefend auf ,Neuen
Kurs anlegen”: Alternativ konnen Sie die Kursanlage auch lber ,Website-Administration > Kurse > Kurse und
Kursbereiche verwalten” aufrufen oder in der Navigationsleiste ganz oben auf ,Meine Kurse” klicken und
anschlieBend auf den Button ,Kurs erstellen” gehen:

Neuen Kurs anlegen

v Allgemeines

L "0 @
Kusberech @ @
Such v
Kusschbaret @ |
Farso o 8
er o 8 o
ke
LS a

Beschreibung

Kursformat

Darstellung

Dateien und Uploads

Abschlussverfolqung

In der Eingabemaske konnen Sie Eckdaten zum Kurs wie Name und Kurzbezeichnung, die Kursdaten, das
Erscheinungsbild des Kurses uvm. festlegen. Ndhere Informationen hierzu finden Sie hier.

Anlegen von Kursen durch Trainer:innen

Wenn Sie mochten, dass auch Trainer:innen auf lhrer Instanz einen Kurs anlegen konnen sollen, kann dies u. a.
vorgenommen werden, indem Sie fur jede:n Trainer:in einen Kursbereich anlegen und diesem:dieser dann in
dem jeweiligen Kursbereich Rechte als ,,Manager/in“ zuweisen.

Das funktioniert, indem Sie in der Ubersicht der Kursbereiche auf das Dreipunkt-Menii neben dem jeweiligen
Kursbereich klicken und ,, Rechte” auswéahlen:

Kursbereiche und Kurse bearbeiten

Kursbereiche
Neuen Kursbereich anlegen
I Verschiedenes ® +[i] =
Demokurs & Anzeigen .
# Bearbeiten
Grundlage & Neuen Kursunterbereich anlegen =
W Loschen
+ Kurssamm 3
it mnas = Glohale Goinnen

Klicken Sie anschlieend links oben auf ,,Rechte”, um ein Dropdown-Meni zu 6ffnen und wahlen Sie den Punkt
,Rollen zuweisen” aus:

Rechte ~

ursbereich: Verschiedenes

Rollen zuweisen

¥  Rechte
Auswihlen ... s
Rechte priifen

Im nachsten Schritt auf ,,Manager/in“ klicken und den gewlinschten User auswéahlen:
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Rolle ‘Manager’ in ‘Kursbereich: Lehrgang ABC' zuweisene
Derzeit zugewiesene Nutzeraccounts Magliche Nutzer/innen

Nichts in dieser Kursbereich Magliche Nutzer/innen passend 2u ‘hannes’ (1)
Hannes Lehver (testiererbyom.de)
Nutzer/innen von System (1)

~vinzusugen (@)

Suchen Losche suchen | hanres () Loschen

Suchaptionen »

Nach Klick auf ,Hinzufligen” kann der User ,,Hannes Lehrer” im Kursbereich , Lehrgang ABC” selbststandig Kurse
anlegen. Dazu einfach in der Navigationsleiste ganz oben auf ,Meine Kurse” klicken und anschlieRend den
gewlinschten Button bestatigen:

demo st Dt [ NEROY
Meine Kurse Kurse verwalien

Kursiibersicht

V& Beispietirs
~ ) [ i
d ) —

— | unterhersich Test

In der Kursverwaltung kénnen dann zwar alle Kursbereiche und Kurse angesehen werden, jedoch kann ,Hannes
Lehrer“ neben den Kursen, in denen er als Trainer oder Teilnehmer eingetragen ist, nur die Kurse im Kursbereich
»Lehrgang ABC“ aufrufen bzw. ausschlieBlich dort neue Kurse anlegen.

Bitte beachten Sie: Wenn eine Person einen Kurs anlegt, ist sie dort nicht automatisch als Trainer:in eingetragen.
Sie misste sich selbst (wie unten beschrieben) in den jeweiligen Kurs einschreiben, damit der Kurs z. B. auch in
der Kursibersicht unter ,Meine Kurse” aufscheint.

Einschreiben von Trainer:innen in einen Kurs

Nach dem Anlegen des Kurses kdnnen Sie die jeweiligen Trainer:innen einschreiben. Klicken Sie dazu in der
Navigationsleiste des Kurses auf ,Teilnehmer/innen“ und anschlieRend auf den Button ,Nutzer/innen
einschreiben”:

Demo-Kurs

Kurs Einstellungen Teilnehmer/innen Mehr ~
Eingeschriebene Nutzer/innen - | Nutzer/innen einschreiben |

L

Finde | Reliebin * | | Auswanl

Im Anschluss kénnen Sie im Suchfeld (Ziffer 1) nach den entsprechenden Usern suchen. Wahlen Sie bei ,, Kursrolle
zuweisen” (Ziffer 2) die Rolle , Trainer/in“ aus und bestatigen Sie mit Klick auf ,,Nutzer/innen und globale Gruppen

einschreiben”:
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MNutzer/innen einschreiben x

Einschreibeoptionen

Nutzer/innen auswahien  (( David BRS —— )

0
Globale Gruppen Keine Auswahl
auswahlen
Suchen v
Kursrolle Zuweisen Trainer/in + o
Mehr anzeigen ...
Abbrechen Nutzer/innen und globale Gruppen einschreiben

Die Personen, die in einem Kurs als Trainer:in eingeschrieben sind, kénnen ihre jeweiligen Kursteilnehmer:innen
nun in den Kurs eintragen und natirlich auch die Kursinhalte entsprechend bearbeiten.

Hinweis: Wenn eine Person einen Kurs selbst anlegt, ist sie dort nicht automatisch als Trainer:in eingetragen. Sie
misste sich selbst (wie beschrieben) in den jeweiligen Kurs einschreiben, damit der Kurs z. B. auch in der
Kursibersicht unter ,,Meine Kurse” aufscheint.

Fir Trainer:innen:
Konfigurieren eines Kurses

Erste Schritte - Aufrufen der Einstellungen

Hinweis: StandardmaRig ist das Anlegen von Kursen fiir Trainer:innen nicht moglich — der:die Administrator:in
kann hierfir allerdings die jeweiligen Rechte vergeben. Ndhere Informationen dazu finden Sie unter ,Fur
Administrator:innen: Kursbereiche und Kurse anlegen und konfigurieren”.

Auch wenn Sie nicht die Rechte zum Anlegen eines Kurses besitzen, kdnnen Sie einen Kurs, in dem Sie
Trainer:innenrechte besitzen, uneingeschrankt bearbeiten.

Verwendung des Designs ,,Boost”

Im oberen Bereich des Kurses befindet sich eine Navigationsleiste, liber die Sie flr den Kurs, in dem Sie sich
befinden, bestimmte Einstellungen vornehmen kénnen (griin markiert):

demo  Startseite Dashboard Meine Kurse Do H o~ Bearbeiten @

Demo-Kurs

Kurs Einstellungen Teilnehmer/innen Bewertungen Berichte Mehr v

Diese Leiste nimmt vor allem fiir Sie als Trainer:in, aber auch fiir die anderen Personen im Kurs eine wichtige
Rolle ein, da die Navigation so wesentlich erleichtert wird.

Klicken Sie zum Aufrufen der Kurseinstellungen auf , Einstellungen” (rot markiert). Wenn Sie einen Kursinhalt (z.
B. eine Aktivitat) geoffnet haben, wird diese Navigationsleiste ebenfalls angezeigt. In diesem Fall beziehen sich
die jeweiligen Menlpunkte auf die einzelne Aktivitat:
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FORU

B Austauschforum

Forum

Einstellungen

Erweiterte Bewertung

Abonnements Berichte

Mehr v

Verwendung des Designs ,,Classic*

Verwenden Sie das Design ,Classic” finden Sie die Einstellungsmoglichkeiten jeweils im Block

Seite angezeigt und bietet die Maoglichkeit,
kontextabhangig fiir einen Kurs, eine Aktivitat ... Einstellungen vorzunehmen.

,Administration”.

Er wird auf jeder

Wenn Sie als Trainer:in beispielsweise eine Aktivitat gedffnet haben, kdnnen Sie Gber den
Block ,Administration” direkt auf die Einstellungen der Aktivitat selbst (Ziffer 1) zugreifen, aber
auch die Kurseinstellungen (Ziffer 2) aufrufen.

Klicken Sie zum Aufrufen der Kurseinstellungen auf , Einstellungen” (rot markiert).

Grundeinstellungen des Kurses

Administration

> Textseite-Administration o

Vv Kurs-Administration a
¥ Einstellungen
> Nutzer/innen
Y Filter
> Berichte
& Setup fur Bewertungen
> Badges
> Fragensammlung
B8 Dateiverwaltungen
m Alte K eien
X LTI Externe Tools
> Zertifikate
B Papierkorb
> Kurs wiederverwenden

> KlI-Fragen

In den Kurseinstellungen selbst (ndhere Informationen dazu auch hier) konnen Sie u. a. den Namen des Kurses,
einen Kurznamen oder auch die Laufzeit des Kurses definieren.

Kursname

Kurzer
Kursname

Kurssichtbarkeit

Kursbeginn

Kursende

Kurs-ID

Kursbersich @ @

Kursbeschreibung @

Neuen Kurs anlegen

Alles aufidappen

~ Allgemeines

Volistandiger @ @ | Demokurs

e e demokurs

@ | Anzeigen

o 158 Juli ® 2025 # 00 = 00 s | =

L] Aktivieren

& Kursende ober die Anzahl der Abschnitte errechnen @

~ Beschreibung

Bearbeiten Ansicht  Einfogen Format Werkzeuge Tabelle  Hilfe

9 B I A

BEE® WM we R -

[ Dieser Kurs begleitet Sie durch unseren Lehrgang!

Einige ausgewdhlte Optionen, die sowohl beim Anlegen eines neuen Kurses als auch beim Bearbeiten eines

bestehenden Kurses festgelegt werden kdnnen, werden an dieser Stelle exemplarisch vorgestellt.

Kursformate

Im Bereich ,Kursformat” konnen Sie verschiedene Darstellungsarten fiir Ihren Kurs auswahlen.

Die wichtigsten sind:

Themenabschnitte

Die Abschnitte des Kurses werden hier in Themen
strukturiert und kdnnen auch von den Trainer:innen
entsprechend benannt werden.
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Es kann ausgewahlt werden, ob die Kursabschnitte Demokurs

mit samtlichen Inhalten komplett untereinander g TS, SO
angezeigt werden sollen oder ob — wie im Screenshot
rechts — nur die Beschreibung des Abschnitts zu sehen »
ist und die Inhalte dann per Klick auf den e e ,
Auf den nachsten Seiten findet ihr Links, und vieles mehr, die fir euch
Kursabschnitt auf einer eigenen Seite angezeigt B o Emme—————
werden.
Niitzliches Allerlei >

Sehr  dhnlich  hierzu ist das  Kursformat
Wochenabschnitte mit dem Unterschied, dass nicht
Themen, sondern Wochen zur Gliederung des Kurses O S Y ol
herangezogen werden.

Umsetzung eures Unterrichts unterstitzen sollen.

B Aktivitsten 13
Modul 1 - 25.9.2019 ]
Am ersten Termin des neuen Ausbildungszyklus dreht sich alles um
Besonders berucksichtigt wurde dabei natirfich auch die TheoPrax-
Methodik.
B Altivititen 26
Demokurs
Gridformat i TBGRRRGE | Ko
Dieses Kursformat stellt die Kursabschnitte als
,Gitter” dar — mit Klick auf einen Kursabschnitt 6ffnen o
sich die jeweiligen Inhalte auf einer eigenen Seite. e mlkommen n disem i
Auf den nachsten Seiten findet ihr Links, M 1] und vieles mehy, die
fur euch in den kommenden Monaten sicher hilfreich sind.
Hinweis: Der Kurs sieht nur dann so aus wie rechts
. . Natzliches Allerlei Modul 1 - 25.9.2019 Modul 2 - 23.10.2019
dargestellt, wenn der ,Bearbeiten“-Modus im Kurs > ®
ausgeschaltet ist. : "Fs
S 1
o sl
} © © © ©
Modul 4 - 1.7.2020 Kontakt

Kachelformat

Die Darstellung der Kursabschnitte im Kachelformat
ist dem Gridformat sehr dhnlich.

Im Gegensatz dazu 6ffnen sich aber die Kursinhalte
unterhalb der Abschnittsiibersicht. Im dargestellten
Beispiel ist dem Abschnitt ,,Modul 2“ kein Bild

Madul 3 - 15.1.2020 x
zugeordnet - stattdessen kénnen die Y

D ks Schibingitag ek gf e e e W verm Aufirag bis e Rbnebbussprisemtation viarars a1+ e
e

Abschnittskacheln mit Icons (wie z. B. dem Stern) e i P
versehen werden. |
Programm und Prisentationsunterlagen
Hinweis: Der Kurs sieht nur dann so aus wie rechts
dargestellt, wenn der ,Bearbeiten“-Modus im Kurs
ausgeschaltet ist.
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Demokurs
Ein-Themen-Format foe el e ompetensen

Bei diesem Format werden die einzelnen

Herzlich willkommen in diesem Kurs!

Kursabschnitte als Karteireiter dargestellt.

Auf den nachsten Seiten findet ihr versc formationen, Links, 1 und vieles mehr, die
far euch in den kommenden Monaten sicher hilfreich sind.

Am ersten Termin des neuen Ausbildungszykius dreht sich
alles um Grundlagen des Projektablaufs und -
managements!

Besonders bericksichtigt wurde dabei natirlich auch die
TheoPrax-Methodik.

Prog und Pr i lagen
,m Programm 25.9.2019
Demokurs
Komprimierte Abschnitte Kus  Teilnehmerfionen  Kompetenzer
In diesem Format werden die Kursabschnitte Herzlich willkommen in diesen Kurs!

Auf den nachsten Seiten findet ihr verschiedenste Informationen, Links, Materialien und vieles
mehr, die fur euch in den kommenden Monaten sicher hilfreich sind

eingeklappt — per Klick auf den Abschnittsnamen

kénnen die jeweiligen Lehrinhalte aufgerufen © Alle aufidappen @ Alle zuklappen

Werden . Hinweis: Ein Klick auf den Abschnittsnamen blendet den Inhalt ein oder aus

Nitzliches Allerlei
Modul 1 - 25.9.2019
Modul 2 - 23.10.2019

@ 0 O
®@ ®@ @ @

Modul 3 - 15.1.2020

Der dritte Schulungstag beschaftigt sich mit dem Weg vom
Auftrag bis zur Abschlussprisentation. Weiters wird ein
Schwerpunkt auf die Bewertung der Projektarbeit gelegt

Programm und Présentationsunterlagen

2] Programm 15.1.2020

Einige allgemeine Informationen zum Thema Kursformate finden Sie hier.

Abschlussverfolgung

Die ,Abschlussverfolgung” erlaubt es lhnen, im Kurs zu definieren, wann eine bestimmte Aktivitdt als
»Abgeschlossen” gilt. So kdnnen Sie einerseits Ihren Kursteilnehmer:innen selbst die Méglichkeit geben, einen
guten Uberblick lber ihren ,Status Quo“ im Kurs zu erlangen oder auch als Trainer:in sehen, inwieweit
Kursinhalte bereits durch lhre Teilnehmer:innen bearbeitet wurden. Andererseits konnen Sie die
Abschlussverfolgung auch einsetzen, um bestimmte Teile eines Kurses nur unter bestimmten Voraussetzungen
freizuschalten.

Die ,,Abschlussverfolgung” muss in einem ersten Schritt auf Systemebene von dem:der Administrator:in aktiviert
werden (das funktioniert Gber das entsprechende Hakerl unter ,, Website-Administration > Zusatzoptionen®).

Durch den:die Trainer:in ist die Aktivierung dieser Funktionalitdt zuerst grundlegend in den Kurseinstellungen
notwendig:
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demo Startsete  Dashboard  Mewne Kurse  Website- Admunestr ation

> Darstellung
> Dateien und Uploads

v Abschlussverfolgung

Abschlussverfolgung @
aktivieren

Abschiussbedingung @
en anzeigen

> Gruppen
> Umbenennen der Rolle ¢

> Tags
CE——— ...

Anschliefend wird bei den einzelnen Kursinhalten in den ,,Einstellungen” (siehe dazu den Beginn dieses Kapitels)
unter ,Abschlussbedingungen” gesondert definiert, unter welchen Bedingungen der jeweilige Kursinhalt als
abgeschlossen gilt:

7 voraussetzungen

~ Abschlussbedingungen

Kesne

> Tane

Grundsatzlich gibt es hier folgende Moglichkeiten:

e ,Keine”: Bei dem jeweiligen Kursinhalt wurden keine Abschlussbedingungen definiert.

e, Teilnehmer/innen mussen die Aktivitdt manuell als erledigt markieren”: Die Kursteilnehmer:innen
kdnnen den jeweiligen Kursinhalt per Mausklick als ,, Erledigt” markieren —dies kann auch vorgenommen
werden, ohne den Inhalt aufgerufen zu haben.

e ,Bedingungen hinzufligen”: Bei Auswahl dieser Option wird ein Kursinhalt automatisch als , Erledigt”
markiert, wenn bestimmte Voraussetzungen erfillt sind.

Diese Voraussetzungen sind je nach Inhaltstyp unterschiedlich und kénnen z. B. sein:

e Aufrufen eines bestimmten Inhalts in einem Kurs

e Durchfihren einer bestimmten Aktion durch den:die Teilnehmer:in (unterschiedlich je nach
Aktivitatstyp) — z. B. Er6ffnen eines Beitrags in einem Forum, Hochladen einer Datei in einer Aufgabe

e Erreichen einer bestimmten Bewertung

Mit Hilfe der Abschlussverfolgung kdnnen sowohl die Kursteilnehmer:innen als auch die Trainer:innen auf einen
Blick sehen, welche Inhalte bereits im Kurs bearbeitet wurden.

Die Kursteilnehmerin in diesem Beispiel hat etwa beim ,Forum” eine der zwei Anforderungen erfillt, die
,Aufgabe” ist vollstdndig abgeschlossen und auch die Textdatei wurde von der Kursteilnehmerin als , Erledigt”
markiert. Dies zeigt sich einerseits bei der Ubersicht der Kursinhalte, andererseits auch (bei Nutzung des Designs
,Boost”) in der Navigation links:
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demo  Startseite Dashboard Meine Kurse L™ “
* J @ Ankiindigungen

~ Aligemeines
v 10.Juli- 16, Ju

~ 10, Juli - 16. Juii (CIEDEENY

Hier die Aufgabe hochladen v Eredigt ~
@ Hier die Aufgabe hochladen m =

15, Juli 2025, 00:00

uli 2025, 00:00
o Textdatei

© Forum fur Teilnehmerinnen he) Textdate + Erledigt
~ 17, Juli - 23_ Juli

[E) Forum fur Teilnehmerinnen 2u erledigen ~
~ 24. Juli - 30. Juli g

. Sie milssen
~ 31. Juli - 6. August
+ Themen hinzufugen:

v 7. August - 13, August ~ 17 Juli - 23, Juli + antworten senden: 1

w14 Bumset . 20 Aunuet

Der Kursleiter sieht dies tber die Kurseinstellungen > Berichte > Aktivitdtsabschlussbericht folgendermalen:

Aktivitdtsabschluss -

EinschlieBeny lle Akrivitzten und Materialien ¢ | Aktivititsreihenfolge Reinenfolge im kurs ¢

Abschaitt  Nicht nach Abschnit filtem &

Vomame

jier die Aufgabe hachl sden

€
18 =2

Néhere Informationen zum , Aktivitatsabschluss” finden Sie hier.

Hinweis: Neben dem beschriebenen , Aktivitdtsabschluss” kann auch noch ein , Kursabschluss” aktiviert werden
— in diesem Fall werden Bedingungen definiert, unter denen ein Kurs als abgeschlossen gilt. Nahere
Informationen hierzu finden Sie hier.

Voraussetzungen

Mit Hilfe von ,Voraussetzungen” kdnnen Sie den Zugriff auf bestimmte Inhalte so einschrdanken, dass hierfur
bestimmte Bedingungen erfiillt sein miissen oder nicht erfillt sein diirfen. Diese Bedingungen kdnnen zeitlicher
Natur sein (sodass ein Inhalt erst ab oder nur bis zu einem bestimmten Zeitpunkt verfugbar ist); es kann aber u.
a. auch definiert werden, dass nur Mitglieder einer bestimmten Gruppe einen Inhalt aufrufen diirfen, dass fir
gewisse Inhalte eine bestimmte Bewertung erreicht werden muss oder dass eine (oder mehrere) andere
Aktivitaten abgeschlossen sein missen.

,Voraussetzungen” missen in einem ersten Schritt auf Systemebene von dem:der Administrator:in aktiviert
werden (das funktioniert Gber das entsprechende Hakerl unter ,,Website-Administration > Zusatzoptionen®). Auf
Wunsch kénnen noch unter ,Website-Administration > Plugins > Voraussetzungen” bestimmte Arten von
Voraussetzungen auf der gesamten Instanz ausgeblendet werden.

Durch den:die Trainer:in wird die Funktionalitdt jeweils direkt in > Weitere Einstellungen
der jeweiligen Aktivitat/dem jeweiligen Arbeitsmaterial aktiviert. v Voraussetzungen
Dies funktioniert in den ,Einstellungen” des jeweiligen Kursinhalts b s Vil
Uber den Punkt ,Voraussetzungen®. Klicken Sie in einem ersten Voraussetzung hinzufigen
Schritt auf den Button ,Voraussetzung hinzufligen”:

> Aktivitatsabschluss

Im Anschluss kdnnen Sie die Kriterien definieren, die erfiillt sein miissen bzw. nicht erfiillt sein dirfen und kdnnen
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auch festlegen, ob ,alle” oder ,mindestens eine” der Voraussetzungen zutreffen missen, um einen Inhalt
aufrufen zu kénnen:

7 vvellere cinstenungen

v Voraussetzungen

Voraussetzungen
Teinehmer/in | muss ¢ | von den folgenden Bedingungen

¢ | erfulien

Aktivitatsabschluss

Voraussetzung hinzufiigen

5>  Aherhliicchadinannnan

Mit Hilfe des Auge-Symbols (siehe Markierung) kdnnen Sie festlegen, ob die Teilnehmer:innen den jeweiligen
Inhalt und die dazugehdrigen Kriterien gar nicht sehen sollen, wenn die entsprechenden Kriterien nicht erfillt
sind, oder ob die Inhalte ausgegraut erscheinen sollen. In diesem Fall wird der jeweilige Kursinhalt so angezeigt:

@ Forum fiir Teilnehmerinnen

@ Nicht verfiigbar, auBer: Sie sind in Gruppe 1

N&here Informationen zu diesem Thema finden Sie hier.

‘,.Qh‘f‘l Education
T Group Moodle 4.5 | Stand 2025 34

Die Bildungsagentur


https://docs.moodle.org/405/de/Voraussetzungen

&

Lernplattform 00 _ HANDBUCH UND Tzpps Er)
FUR DIE VERWENDUNG

Fur Trainer:innen:
Inhalte in einen Kurs hinzufiigen

Aktivieren des ,Bearbeiten“-Modus

Nach dem Anlegen bzw. grundlegenden Konfigurieren eines Kurses geht es an das Hinzufligen von Inhalten.
Aktivieren Sie hierfir den ,,Bearbeiten“-Modus.

Verwendung des Designs ,,Boost”

Um Anderungen an den Inhalten lhrer Instanz vorzunehmen, miissen Sie zunichst den ,Bearbeiten-Modus
aktivieren. Einen entsprechenden Regler zum Aktivieren bzw. in der Folge zum Deaktivieren finden Sie rechts
oben — klicken Sie diesen einfach an:

demo Startseite Dashboard Meine Kurse Website-Administration 0 © IS Bearbeiten (.:)

e-Learning Portal

Startseste Einstetiungen Tevinehmer/innen Benchte Fragensammiung Mehs v

Im Anschluss konnen Sie auf lhrer Instanz neue Inhalte (Blocke, Kursabschnitte, Aktivititen/Materialien ...)
hinzufligen, bestehende Inhalte bearbeiten oder diese an eine andere Stelle verschieben. Dazu dienen die
entsprechenden Links in Textform bzw. die entsprechenden Symbole:

Demoinstanz + Block hinzufgen

Stanseite Einstellungen Teilnehmer/innen Berichte Fragensammiung Mehr +

Hauptmenti L
]
L fl& Anwesenheit #

Herzlich willkommen auf unserer Lernplattform! w B ”;“““““ Forum

+ Altivitht oder Material
L) — =
ONLINE

LEARNING Kalender L

- Juli 2025 -

Mo Di Mi Do Fr Sa So
1T 2 3 4 5 &

T8 9 W N o1 13

uoﬁ 7B 19 0

+
[E) Noch Fragen? Hier entiang! # H TR R T VR PO A
® ¥ 0 n
+ Aktivitit oder Material anlegen
Volistandiger Kalender + Import und
Maina Kurca Frport
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Um Anderungen an den Inhalten lhrer Instanz vorzunehmen, miissen Sie in einem ersten Schritt den
,Bearbeiten“-Modus aktivieren. Den Button zum Aktivieren bzw. Deaktivieren finden Sie rechts oben:

demo Devtsch (oe) ~

Demoinstanz

[ PO S —

Technacher Support 1S ©

Bearbeiten einschalten

Kursberexche

W Macelaneous

Im Anschluss konnen Sie auf lhrer Instanz neue Inhalte (Blocke, Kursabschnitte, Aktivititen/Materialien ...)
hinzufligen, bestehende Inhalte bearbeiten oder diese an eine andere Stelle verschieben. Dazu dienen die

entsprechenden Links in Textform bzw. die entsprechenden Symbole:

Demoinstanz

Startseite

Administration L

v Einstellungen der Startseite
# Bearbeiten ausschalten
& Einstellungen
> Nutzer/innen
Y Filter
> Berichte
> Fragensammiung
W Alte Kursdateien
> Kurs wiederverwenden

> Website-Administration

In den Einstellungens | Q

Navigation L

v Startseite
@ Dashboard
> Website
v Meine Kurse

Wichtige Symbole

Herzlich willkommen auf unserer
Lernplattform!

S — 1) —

ONLINE
LEARNING

T

&
(3) Noch Fragen? Hier entlang! £

+ Aktivitiit oder Material anlegen

Bearbeiten ausschalten

Hauptmend P i

;a Anwesenh
¥ eit &

@ Deutsches
L 4 Forum

”

+ Aktivitst oder
Material anlegen

Kalender L

- Juii 2025 -

Mo Di Mi Do Fr Sa So

Die nachfolgenden Symbole finden sich in Ihrer Instanz immer wieder und kdnnen beispielweise bei angelegten
Aktivitaten, Arbeitsmaterialien oder in Blécken auftauchen. Bitte beachten Sie, dass das Aussehen der Symbole
davon abhangig ist, welches Design fiir Ihre Instanz bzw. lhren Kurs festgelegt wurde.

}' Dieses Symbol dient dazu, um ein Element direkt auf der Kursseite umzubenennen.

Bearbeiten eines Elementes beinhaltet.

Dieses Symbol dient zum Aufrufen eines Auswahlmenis, das die verschiedenen Optionen zum

0{-0 Mit Hilfe eines Klicks auf dieses Symbol konnen Sie das entsprechende Element per Drag & Drop

verschieben.
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9 Dieses Symbol zeigt normalerweise nach links oder rechts. Sie bewegen mit einem Klick darauf das
betreffende Element in die jeweilige Richtung (vergleichbar z. B. mit einem Texteinzug).
Hinweis: Dieses Symbol ist nur bei Nutzung der Kursformate ,Wochenformat” bzw. ,, Themenformat”
sowie nach einmaliger Aktivierung durch den:die Administrator:in verfiigbar. Informationen hierzu
finden Sie unter ,Fiir Administrator:innen: Sonstige Hinweise”.

a‘ Bei Klick auf dieses Symbol gelangen Sie in die Einstellungen des Elements, wo Sie verschiedene
Parameter festlegen kénnen.

L! Mochten Sie ein Element kopieren, klicken Sie auf dieses Symbol.

Mit einem Klick auf dieses Symbol wird das jeweilige Element geléscht und in den Papierkorb
verschoben (sofern dieser durch den:die Administrator:in aktiviert wurde).

@ Dieses Symbol zeigt die Sichtbarkeit eines Elements an. Ist das Auge durchgestrichen, kdnnen die
Kursteilnehmer:innen das jeweilige Element nicht sehen. Auf der Kursseite ist — wenn gewiinscht — ein
entsprechender Hinweis zu sehen.

P Mochten Sie einem:einer Teilnehmer:in eine andere Rolle flir ein bestimmtes Element (z. B. eine

ad Aktivitdt) zuweisen, so geschieht dies hier. Die Person hat dann nur fir dieses Element eine andere
Rolle — dies gilt nicht flir den gesamten Kurs. Dies kénnte beispielsweise zum Einsatz kommen, wenn
etwa ein:e Teilnehmer:in die Rolle eines:einer Moderator:in in einem Forum libernehmen soll.

@ Dieses Symbol bezieht sich auf den so genannten ,Gruppenmodus”. Damit wird festgelegt, ob die
Teilnehmer:innen in Gruppen arbeiten und ob sie die Arbeit anderer Gruppen sehen kénnen. Ndhere
Informationen zu Gruppen finden Sie hier.

Einige Informationen zum Bearbeiten eines Kurses finden Sie auch hier.

Kursabschnitte anlegen

Mit Hilfe von Kursabschnitten kann ein Kurs Ubersichtlich strukturiert werden. Hierfir gibt es verschiedene
Moglichkeiten: So kénnte ein Kursabschnitt beispielsweise einer Woche entsprechen; Kursabschnitte kdnnen
aber auch fur die Strukturierung nach Themen oder Modulen eingesetzt werden.

Klicken Sie zum Anlegen eines Kursabschnittes einfach nach [ TGy
Aktivieren des Bearbeitungsmodus auf den Punkt ,Abschnitt +

hinzufiigen” bzw. ,Woche hinzuftigen” in Ihrem Kurs.

+ Abschnitt hinzufigen

Zumeist ist dieser ganz unten im Kurs zu finden —in diesem Fall -
. . . ape . . e = Karhel 1
kénnen Sie den jeweiligen Abschnitt im Anschluss an das “

Anlegen per Drag & Drop an die gewlinschte Stelle verschieben.

Hinweis: Falls Sie mit dem Kursformat , Grid“ arbeiten, funktioniert das

+
Anlegen von Kursabschnitten ebenfalls ganz unten im Kurs — allerdings
wird die Funktion erst sichtbar, wenn Sie mit der Maus Uber die Flache F---------=---= @ ---------------
unterhalb des letzten Kursabschnitts fahren. Abschnit hinzufdgen]

v
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Nadheres zu den verschiedenen Kursformaten ist im Kapitel ,Flr Trainer:innen: Konfigurieren eines Kurses”
zusammengefasst; Informationen rund um Kursabschnitte sind hier nachzulesen.

Kursinhalte anlegen

Wenn Sie den ,Bearbeiten“-Modus in lhrem Kurs aktiviert haben, kénnen Sie Inhalte in lhrem Kurs anlegen.
StandardmaRig sehen Sie im mittleren Bereich lhres Kurses den Punkt , Aktivitat oder Material anlegen”:

v Allgemeines «» Alles einklappen

‘ Aktivitat oder Material anlegen

Wenn Sie auf diesen klicken, 6ffnet sich die Ubersicht der verfiigbaren , Aktivititen” und , Materialien“. Niheres
hierzu finden Sie unter ,Arten von Inhalten in einem Kurs*“.

Wahlen Sie hier den gewlinschten Inhaltstyp aus. Die darauffolgende Eingabemaske unterscheidet sich je nach
Inhaltstyp — einige Elemente kommen allerdings in den meisten Fallen vor:

A"gememes @ Forum hinzufiigene
Alles sufklappen
Hier werden ganz oben der Name des jeweiligen v Allgemeines
Elements (Pflichtangabe) sowie — wenn gewinscht — Foummmame @ |
eine Beschreibung angegeben. Teilweise kdnnen an Beschreiburs a-]B1][=E %% w
dieser Stelle auch z. B. Anleitungen oder zusatzliche mEaalsiee
Dateien hochgeladen werden.
Hinweis: Bei Anlegen einer Aktivitdit vom Typ
,Interaktiver Inhalt” wird der Name der Aktivitdt im - . 4
[0 Beschreibung im Kurs zeigen
Bereich , Editor” eingetragen, ist aber ebenfalls eine
Pflichtangabe.
8 Interaktiver Inhalt hinzufiigene
Beschweiung 1 A B I E2EE %S @
wWoE R N e

[ Beschreibung im Kurs Zeigen @

Editor HPha  interactive Video ¥

o Tutorial o Beispiel @ Kopiersn | D) Grfugen & Ersetzen

® HsP-Test ]

Name *
Wird i

H3P-Test

und Usheberrechtsinformationen benutt

WM video hochla @ interaktione @ zusammenta.
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Verfiigbarkeit

Mit Hilfe dieser Einstellung kdnnen Sie festlegen,
wann ein bestimmter Inhalt fiir die Teilnehmer:innen
sichtbar sein soll.
Je nach Element kénnen hier noch weitere Eckdaten
definiert werden.

v Verfiigbarkeit

Abgabebeginn @ B Aktivieren

Falligkeitsdatum @ BAktiviersn 17 # ul s

2023 =

Bewertung

Abschnitt werden  verschiedene

Grundeinstellungen zur Bewertung des Elements

In  diesem

getatigt — beispielsweise, wie viele Punkte maximal

erreicht werden koénnen, wie viele Versuche
zugelassen werden, welche Rollen Bewertungen

vornehmen dirfen uvm.

Auch hier
Optionen je nach Typ des Elements — auf der rechten

unterscheiden sich die verflgbaren

Seite sehen Sie zwei Beispiele.

Nadhere Informationen dazu gibt es auch im Kapitel
,Bewertungen” in diesem Handbuch zu finden.

Letzte © O Akivieren| 10 * i s
Abgabemaglichkeit
An Bewertung © Badvieren| 24 = || Jul :
erinnern
v Bewertung
Bewertung (=]

Typ| Punkt =

Bewertungsmethode @

Maximalpunkte

100

Einfache direkte Bewertung +

v Bewertung

Bewertungskategorie @

Bestehensgrenze

Erlaubte Versuche

Bewertungsmetho

e |
| Unbegrenzt ¢ |

de @ | Bester Versuch # ‘

| Nicht kategorisiert

+ |

Weitere Einstellungen

Hier kénnen Sie definieren, ob die
Kursteilnehmer:innen das jeweilige Element sehen
bzw. aufrufen koénnen. Zudem kdénnen Sie auch
festlegen, ob bei dem jeweiligen Kursinhalt eine
andere Sprache zum Einsatz kommen soll bzw. auch

Einstellungen zur Arbeit mit Gruppen tatigen.

Nahere Informationen hierzu finden Sie hier.

v Weitere Einstellungen

verfugbarkeit ®

1D-Nummer (]

Sprache erzwingen

Gruppenmodus (7]

Gruppierung )

Auf Kursseite anzeigen

Nicht festiegen &

Sichtbare Gruppen

Keine

Voraussetzung fir Gruppe/Gruppierung hinzufge

Voraussetzungen

Mit diesen Einstellungen kdnnen Sie — sofern durch
den:die Administrator:in auf Systemebene sowie
durch Sie als Trainer:in auf Kursebene aktiviert — den
Zugriff auf bestimmte Inhalte so einschranken, dass
hierfir bestimmte Bedingungen erfillt sein missen
oder nicht erfullt sein dirfen.

Nahere Informationen dazu finden Sie im Kapitel ,,Flr
Trainer:innen: Konfigurieren eines Kurses”.

~ Voraussetzungen

Voraussetzungen

Teilnehmer/in

alle # | erullen

@ Guppe | Gruppe

und

Bewertung | Kurs gesamt

B muss = sein| 70

muss < sein

Voraussetzung hinzufigen

% | von den folgenden Bedingungen
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Aktivitatsabschluss v Aktivititsabschluss

Abschlussverfolgung @ Abschluss wird manuell markiert

Hier kdnnen Sie festlegen — sofern durch den:die

Abschiusstermin @ @ aktivieren| 10 3 Juli :

i}

Administrator:in auf Systemebene sowie durch Sie als
Trainer:in auf Kursebene aktiviert — unter welchen
Bedingungen eine  bestimmte  Aktivitat als
,Abgeschlossen” gilt.

Nahere Informationen dazu finden Sie im Kapitel ,,Flr
Trainer:innen: Konfigurieren eines Kurses”.

Neben Aktivitdten und Arbeitsmaterialien kdnnen in einem Kurs auch so genannte Unterabschnitte angelegt
werden, um die Kursinhalte noch besser zu strukturieren. Diese Option muss allerdings durch den:die
Administrator:in einmalig aktiviert werden. Informationen hierzu finden Sie im Kapitel ,,Fiir Administrator:innen:
Sonstige Hinweise”.

In diesem Fall sehen Sie im Kurs nicht den Text , Aktivitdt oder Material anlegen, sondern ein Plus-Zeichen und
konnen lber dieses entweder Kursunterabschnitte oder eben Aktivitdten bzw. Materialien anlegen:

v 10. April - 16. April » ;

L

B Aktivitat oder Material
B Unterabschnitt

v 17. April - 23. April » ;

Nahere Informationen zu Unterabschnitten finden Sie auch hier.
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Das Anlegen von Blocken funktioniert ganz dhnlich wie das Anlegen von Arbeitsmaterialien bzw. Aktivitdaten:

Wenn der ,Bearbeiten“-Modus auf lhrer Instanz aktiviert wurde, finden Sie rechts oder links auf Ihrer Instanz

den Menitpunkt ,Block hinzufligen” bzw. je nach dem auf der Instanz aktiven Design auch ein Block ,Block

hinzufliigen” mit einem Dropdown-Mendi, in dem sich alle verfligbaren Blocke befinden.

Informationen zu Blécken finden Sie im Kapitel ,,Arten von Inhalten in einem Kurs”“.

Block hinzuflgen

‘ Hinzuftigen... s ‘

Bearbeiten von Kursinhalten

+ Block hinzufigen

Die Inhalte in einem Kurs lassen sich von den jeweiligen Trainer:innen ganz einfach bearbeiten:

Wenn in einem Kurs der Bearbeiten-Modus aktiviert

wurde, sehen Sie neben jedem Kursinhalt
entsprechende Symbole: Direkt auf der Kursseite sind
dies einerseits der Stift (rote Markierung), der zum
Umbenennen des jeweiligen Elements dient;
andererseits verbergen sich hinter den drei Punkten
rechts neben dem jeweiligen Element (griin markiert)
die jeweiligen Bearbeitungsoptionen. Bei Klick auf
,Einstellungen bearbeiten” gelangen Sie zu derselben
Eingabemaske, die auch beim Anlegen eines Elements
zum Einsatz kommt und kdénnen dort dann die

gewdinschten Einstellungen anpassen.

Mit dem Button ,Sammelaktionen” rechts oben in

einem Kurs kénnen Sie in einem Schritt gleich mehrere per Hakerl ausgewahlte

aae

In diesem Kurs finden Sie einen U ber viele i und L , die die Lerr
eduACADEMY bietet. Alle Module sind so in den Kurs eingebettet, dass Sie das jeweilige Modul selbst
ausprobieren kinnen und gleichzeitig Wissenswertes Gber die Verwendung des Moduls erfahren. Sie kénnen
sich aus der Perspeklive eines bzw. einer Lemenden an den Aktivitaten beiteiligen und auf diese Art und Weise
Beispiele und Ei ogli iten kennen lernen, die Sie vielleicht schon bald selber in die Praxis
umsetzen kannen.

(3 Nachrichtenforum

Einstellungen bearbeiten
Verschieben
Nach rechts schieben

o
3
>
@ Verfugbarkeit >
L @ Duplizieren
2 Rollen zuweisen
@ Gruppenmodus > I
L]

Loschen

Sammelaktionen #

Kursinhalte aus- bzw. einblenden, sie duplizieren, verschieben oder I6schen:

[% WiKi: Geheimtipps fur Reisende

3

( [ﬁ Anleitung fur das Mitarbeiten an einem Wiki

)

O [Bh. narenhank: Sevaifancta fivr dia Kraatiitst

® L]

[ Alle auswahlen

L3 [} x

Verflgbarkeit — Duplizieren  Verschieben  Léschen 2 ausgewahit
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Dateien und externe Repositories

Natirlich kénnen Sie Ihre Instanz auch dafiir nutzen, fur Ihre Benutzer:innen Dateien zur Verfligung zu stellen.
Diese kdnnen einfach per Drag & Drop in Ihre Instanz hochgeladen und dort dann bereitgestellt weden.

Zusatzlich gibt es auch die Moglichkeit, Ressourcen aus externen Repositories in lhre Kurse zu integrieren.
Unterstitzt werden dabei u. a. Microsoft OneDrive, | Dateiauswahl x
YouTube, Nextcloud, Wikimedia Commons oder Google | = musgece B =

# Dateien in Kurse

Drive — Dateien aus diesen Quellen kénnen einfach per | = »
Mausklick in den entsprechenden Kurs eingebunden e auswaen ] Keine susgewah

& URL-Downloade Speichem unter

werden. Es ist daneben u. a. auch moglich, Dateien durch

die Angabe einer URL zu importieren. 3 Whmedto Commons  Auterfn

Der Zugriff auf samtliche Dateien erfolgt Uber den ienz wen @
Dateibrowser auf Ihrer Instanz - dieser bietet damit eine e
einheitliche Schnittstelle fur den Zugriff auf externe und

interne Ressourcen.

Nadhere Informationen zum Dateibrowser sind hier zu finden; rund um Repositories kénnen Sie hier Details
nachlesen.

Arten von Inhalten in einem Kurs

Arbeitsmaterialien

Unter einem Arbeitsmaterial versteht man einen statischen Inhalt, der von dem:der Trainer:in in einem Kurs zur
Verfligung gestellt wird.

Nahere Informationen dazu finden Sie hier.
Die wichtigsten verfiigbaren Arbeitsmaterialien sind:

e Buch:
Das Buch ist ein einfach strukturiertes, mehrseitiges Lernmaterial und erlaubt die Erstellung von
buchartigen Webseiten in lhrem Kurs mit dem groRBen Vorteil, dass lange Texte vermieden werden. Blicher
konnen Uber Haupt- und Unterkapitel verfiigen und sind an sich nicht interaktiv, ermoglichen aber die
Einbindung von Links sowie von Multimedia-Inhalten.

e Datei bzw. Verzeichnis:

In Kursen koénnen verschiedenste Dateien — es empfiehlt sich vor allem das Zurlckgreifen auf
plattformunabhdngige Dateitypen wie PDF —zugdnglich gemacht werden. Mehrere Dateien kdnnen auch in
Form eines Verzeichnisses zur Verfligung gestellt werden.

e Link/URL:

Mit Hilfe dieses Arbeitsmaterial-Typs kénnen Sie direkt von lhrer Instanz aus auf externe Quellen verlinken.

e Text- und Medienfeld:
Mit einem Textfeld haben Sie die Moglichkeit, Inhalte (Texte, Bilder, Multimedia...) direkt auf der Kursseite
zwischen lhren anderen Kursinhalten einzufiuigen. Dieser Arbeitsmaterial-Typ ist auch nutzlich fir das

Einflgen von Zwischeniberschriften oder die optische Gliederung des Kurses.
e Textseite:

v

‘,.Qh‘f‘l Education
T Group Moodle 4.5 | Stand 2025 42

Die Bildungsagentur


https://docs.moodle.org/405/de/Arbeiten_mit_Dateien_und_Verzeichnissen
https://docs.moodle.org/405/de/Repositories
https://docs.moodle.org/405/de/Arbeitsmaterialien
https://docs.moodle.org/405/de/Buch
https://docs.moodle.org/405/de/Datei
https://docs.moodle.org/405/de/Verzeichnis
https://docs.moodle.org/405/de/Link/URL
https://docs.moodle.org/405/de/Text-_und_Medienfeld
https://docs.moodle.org/405/de/Textseite

Lernplatiform 00 _ HANDBUCH UND T1pps E@
FUR DIE VERWENDUNG

Mit dem Arbeitsmaterial-Typ Textseite konnen Sie umfangreiche Texte mit Grafiken, Bildern usw. als eine
eigene Seite im Kurs zur Verfligung stellen.

e Universelles Textfeld (Unilabel):
Dieses Modul dient zur ansprechenden Darstellung von textbasierten Inhalten — etwa als Slider, Akkordeon

oder Kurs-Teaser — und ermoglicht eine strukturierte, Ubersichtliche Kursgestaltung mit interaktiven
Elementen, ganz ohne HTML-Kenntnisse.

Texteditoren

Fir die Bearbeitung von Texten sind zwei unterschiedliche Texteditoren auf Ihrer Instanz installiert.

StandardmaRig (sofern keine anderen Einstellungen getroffen wurden) ist der TinyMCE-Editor voreingestellt.
Hierbei handelt es sich um einen sehr machtigen und gleichzeitig nutzerfreundlichen Editor, der eine Vielzahl an
Funktionen unterstiitzt. Ndhere Informationen zu TinyMCE gibt es hier zu finden.

Als alternativer Texteditor — und in der Vergangenheit Standard — steht daneben der Atto-Editor zur Verfligung,
der sehr intuitiv verwendbar ist und viele praktische Funktionalititen bietet. Einen Uberblick zum Atto-Editor
finden Sie hier.

Hinweis: Entscheidend fur den Funktionsumfang der unterschiedlichen Texteditoren sind die durch den:die
Administrator:in getroffenen Grundeinstellungen — ndhere Informationen dazu finden sich im Kapitel ,Fir
Administrator:innen: Sonstige Hinweise”.

Aktivitaten

Aktivitdten sind Inhaltstypen, die normalerweise eine interaktive Komponente fur die Kursteilnehmer:innen
beinhalten. Auf lhrer Instanz kdnnen Sie verschiedenste Aktivitaten in lhren Kursen nutzen — angefangen von
Kommunikationstools {iber interaktive Tests und Ubungen bis hin zu Videokonferenzen direkt in lhrer Instanz.
Auch die Abgabe und Beurteilung von Hauslibungen bzw. Seminararbeiten kdnnen Sie einfach tber Ihre Instanz
abwickeln.

Grundsatzliche Informationen rund um Aktivitdten finden Sie hier.

Einige haufig genutzte Aktivitdtstypen sind:

Aufgabe

Mit Hilfe der Aktivitdt , Aufgabe” kdnnen die Kursteilnehmer:innen Losungen zu Aufgaben in einem Kurs
abgeben, die dann von den jeweiligen Trainer:innen direkt in der Instanz bewertet werden. Ihre Lernplattform
bietet verschiedene Mdoglichkeiten der Abgabe — vor allem wird hier mit der ,Dateiabgabe” gearbeitet: Die
Kursteilnehmer:innen laden als Lésung der Aufgabe eine Datei hoch — die Trainer:innen kdnnen dann direkt in
der Datei Korrekturen vornehmen, (wenn beim Anlegen der Aufgabe entsprechend definiert) zusatzlich Feedback
in Textform abgeben und natirlich die abgegebene Aufgabe bewerten.

Sofern lhre Institution eine Software zur Plagiatsprifung im Einsatz hat, die lber eine Moodle-Integration
verflgt, kdnnen die abgegebenen Aufgaben auch durch diese Gberprift werden, allerdings stellen wir lhnen
hierfir lediglich die erforderlichen Schnittstellen zur Verflgung.

BigBlueButton

Mit der Aktivitat , BigBlueButton“ kénnen Sie einen Raum fiir eine Videokonferenz auf Ihrer Instanz einrichten.
StandardmaRig ist hier ein BigBlueButton-Testserver hinterlegt, der kostenlos ist, allerdings liber gewisse

v
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Einschrankungen verfiigt. Alternativ zu diesem kostenlosen Angebot kann auch auf einen eigenen BigBlueButton-
Server zurlickgegriffen werden.

Die Aktivitat ,BigBlueButton” muss durch den:die jeweilige:n Administrator:in einmalig aktiviert werden, bevor
sie auf der Instanz verfligbar ist. Ndhere Informationen dazu finden sich hier sowie im Kapitel ,Flr
Administrator:innen: Sonstige Hinweise”.

Alternativ zu BigBlueButton konnen Videokonferenzen auch mit anderen Tools wie Teams oder Zoom
(kostenpflichtige Accounts erforderlich) erstellt werden.

Feedback

Mit Hilfe der Aktivitat ,Feedback” kénnen Sie eigene Umfragen oder Evaluationen erstellen. So kdnnen
hervorragend der Verlauf eines Kurses oder der Trainer bzw. die Trainerin selbst evaluiert werden. Das Feedback
kann auf Wunsch auch anonym eingeholt werden; auch das mehrmalige Ausfillen des Feedbackbogens durch
die Teilnehmer:innen ist moglich.

Auf den Feedback-Bogen konnen verschiedene Fragetypen eingesetzt werden (Multiple-Choice, Textantworten,
Numerische Antworten) — Feedback-Bogen konnen zudem als Vorlage definiert und damit (auch
kurstbergreifend) mehrfach genutzt werden.

Forum

Ein ,Forum” dient nicht nur zur Kommunikation und dem Austausch der Teilnehmer:innen untereinander, es
kann auch dazu genutzt werden, um unkompliziert Informationen an alle Kursteilnehmer:innen zu verteilen
(auch per E-Mail).

Im Zuge der Anlage eines Forums kann definiert werden, ob die Kursteilnehmer:innen das Forum verbindlich
abonnieren (und damit in jedem Fall Gber Postings informiert werden) oder ob sie beispielsweise die Moglichkeit
haben, ein optionales Abonnement abzuschliefZen.

Eine Sonderform des Forums nennt sich ,,Ankiindigungen®. Es wird automatisch in jedem Kurs angelegt und dient
zur Weitergabe von Mitteilungen der Kursleitung an die Teilnehmer:innen. Normalerweise gibt es pro Kurs genau
ein Ankindigungs-Forum.

Glossar

Ein ,Glossar” ist eine listenartige, einfache Darstellung von Daten und gleicht einem Nachschlagewerk.
Ublicherweise werden die Glossareintrdge von den Kursteilnehmer:innen erstellt und kénnen durch den:die
jeweilige:n Trainer:in (sofern entsprechend definiert) auf Wunsch auch freigegeben, kommentiert oder bewertet
werden. Es werden verschiedene Anzeigeformate angeboten, um einen moglichst breit gefacherten Einsatz zu
ermoglichen. Die Eintrdge konnen verschiedenen Kategorien zugeordnet werden und auf Wunsch auch
automatisch verlinkt werden.

Optional kdnnen Glossare nicht nur in einem Kurs, sondern auch kursiibergreifend verfligbar sein, sodass die
Eintrdge im Glossar auch Uber Kursgrenzen hinaus zur Verfligung stehen.

v
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Interaktiver Inhalt (H5P)

HPus inhaitstyp auswihien ~

Die Aktivitaten , Interaktiver Inhalt” bzw. ,H5P“ ermdglichen

das Erstellen von interaktiven Inhalten wie interaktiven

Al Inhaltstypen

Videos, Fragebogen, Prasentationen und vielem mehr. oo o
T Y e—

Einerseits erlaubt diese Funktionalitat es, H5P-Dateien zu - o
importieren und zu exportieren, andererseits kénnen mit Ea—— e
Hilfe des integrierten Editors mit wenigen Mausklicks & "
verschiedenste Inhalte erstellt werden. 5] oreere

B mesm >

7 Bt e (s otemenmen )
Hinweis: Die beiden Aktivititen ,H5P“ (blaues Symbol — & o * Ooermenner

standardmaRig im Core enthalten) und , Interaktiver Inhalt”

(schwarzes Symbol — auf Ihrer Instanz als zusatzliches Plugin installiert) haben grundsatzlich einen sehr dhnlichen
Funktionsumfang. Grundsétzlich bietet jede dieser Aktivitaten ihre Vor- und Nachteile, zudem sind die
Weiterentwicklungen in diesem Bereich aktuell schwer vorhersehbar. Es gibt daher zum derzeitigen Zeitpunkt
keine eindeutige Empfehlung, welches dieser Tools fir lhre H5P-Inhalte das Richtige ist.

Kurszertifikat

Dieses Plugin ermdglicht das Ausstellen von Zertifikaten tUber die Absolvierung eines Kurses. Diese kdnnen durch
den:die jeweilige:n Trainer:in individuell gestaltet werden.

Die Ausstellung der Zertifikate kann auf Wunsch auch automatisiert erfolgen, wenn bestimmte Kriterien erfullt
wurden (z. B. wenn eine bestimmte Bewertung einer Aufgabe erreicht wurde).

Das Zertifikat ist dann entweder direkt im Kurs downloadbar oder wird den jeweiligen Teilnehmer:innen per E-
Mail zugeschickt.

Test

Die Aktivitat , Test" bietet eine Reihe von Moglichkeiten, das Wissen lhrer Kursteilnehmer:innen direkt in lhrer
Instanz zu Gberprifen. Beim Anlegen eines Tests kdnnen Sie bereits diverse wesentliche Eckdaten definieren wie
z. B.:

o  Verfligbarkeit des Tests und Zeitbegrenzung

e Anzahl der erlaubten Versuche

e Bewertung und Bestehensgrenze des Tests

e Ansicht des Tests (wie viele Fragen werden auf einer Seite angezeigt; konnen die Teilnehmer:innen die
Fragen in beliebiger Reihenfolge absolvieren ...)

e  Zeitpunkt des Feedbacks an die Teilnehmer:innen (z. B. jeweils direkt nach einer Frage oder erst nach
Absolvierung des gesamten Tests)

Die Testfragen selbst werden getrennt vom jeweiligen Test in der so genannten , Fragensammlung” gespeichert.
Sie konnen entweder direkt beim Anlegen eines Tests angelegt oder schon zuvor direkt in der Fragensammlung
erstellt werden, sodass sie dann dem jeweiligen Test nur noch hinzugefiigt werden missen. Auf Wunsch kénnen
Sie beim Anlegen des Tests auch zufallige Fragen aus der Fragensammlung hinzufligen lassen.

Einige weitere Informationen zur Fragensammlung haben wir in diesem Handbuch im Kapitel ,,Fragensammlung”
flr Sie zusammengestellt.
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Blocke erfiillen in einer Lernplattform verschiedenste Zwecke: Zumeist unterstitzen sie bei organisatorischen

Belangen, es konnen mit ihrer Hilfe aber auch Text oder Multimedia-Inhalte in einen Kurs eingebunden werden.

Trainer:innen kdnnen normalerweise in ihren Kursen Blécke hinzufligen —in den
meisten Fallen werden diese rechts oder links angezeigt. Bei den meisten
Blocken ist dies nur einmalig auf Ihrer Seite moglich: Sie tauchen, sobald sie
einmal hinzugefligt wurden, nicht mehr in der Liste der verfligbaren Blocke auf.
Eine Ausnahme bildet hierbei z. B. der Textblock.

Mit Hilfe des Pfeils im oberen Bereich eines Blocks kdnnen Sie den Block nach
dem Anlegen an die gewtinschte Stelle verschieben; per Klick auf das Dreipunkt-
Meni gelangen Sie zu den Einstellungen des Blocks und oder kénnen ihn
ausblenden bzw. |6schen.

Hinweis: Bitte beachten Sie, dass sowohl die Maoglichkeit, einen Block
anzulegen, als auch das Vorhandensein der Blécke oder einzelner Menupunkte
sowie deren Aussehen abhdngig vom gewahlten Design lhrer Instanz sowie den
flr Sie gesetzten Berechtigungen sind.

+ Block hinzufugen

Kalender P i
& 'Kalender'
- konfigurieren

Mo @ ‘Kalender verbergen
24 Rechte
7 24 Rechte prifen

T 'Kalender Idschen

14
-

21 22 23 24 25 26 27
28 2% 30 N

Kurskalender
Import und Export

Einige weitere Informationen zum Thema Blécke sowie eine Ubersicht der in der Moodle-Standard-Installation

standardmallig vorhandenen Blécke finden Sie hier.

Dariiber hinaus wurde unser Lernplattform 00O-Stack um zusétzliche Plugins und Blécke erweitert, die auf lhrer

Moodle-Instanz bereits vorinstalliert sind. Einige dieser Erweiterungen mochten wir Ihnen im Folgenden

besonders vorstellen:

7171l Education
g: = Group

Die Bildungsagentur

Moodle 4.5 | Stand 2025

46


https://docs.moodle.org/405/de/Bl%C3%B6cke

Lernplattform 00

Fortschrittsbalken

Sofern in einem Kurs die Abschlussverfolgung aktiviert wurde (siehe
dazu das Kapitel ,Fir Trainer:innen: Konfigurieren eines Kurses®),
konnen die Kursteilnehmer:innen mit Hilfe des , Fortschrittbalkens”

einen raschen Uberblick dariiber erlangen, welche Kursinhalte von
ihnen bereits bearbeitet wurden bzw. welche noch zu erledigen sind
und kénnen auf diese direkt tiber den Block zugreifen. Der:Die jeweilige
Trainer:in kann individuell festlegen, welche Kursinhalte in dieser
Ubersicht beriicksichtigt werden sollen.

w JETZT

{ Limksammlung

&
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Fortschrittsbalken

Micht abgeschlossen &)

Fir den:die Trainer:in selbst bietet der Block zusitzlich die Méglichkeit, einen raschen Uberblick iber den

Bearbeitungsstand aller Teilnehmer:innen zu erlangen. Auch in diesem Fall kann auf die jeweiligen Kursinhalte

direkt per Klick auf das dazugehorige Kastchen zugegriffen werden:

Uberblick Teilnehmer/innen

Rolle student s

Tabellenginstellungen zuriicksetzen

Vnmﬂmem:. B/C D EF G H I LM N O @ R T U WX
Machname WP 4 & ¢ D E F G W I J KL M N OQFQRSTUVWXYZ
Vorname 1=/
[CNachname Fortschrittshalken
- - + -
O rnrea (N Y O
L=
D 3Dani,e\a ---------
ol () B (I Y Y A
B,
N T [ e
o T (N

Level Up XP

Mit diesem Block kénnen Kursteilnehmer:innen durch das Bearbeiten vorab
definierter Aktivitaten Erfahrungspunkte (XP) sammeln. Durch das Erreichen
bestimmter Punktestdnde steigen sie in hohere Level auf. Der Fortschritt wird
Gber Abzeichen und eine grafische Anzeige dargestellt. Optional kann dazu noch
eine (auf Wunsch auch anonymisierte) Rangliste aktiviert werden, die einen
Vergleich mit anderen Kursteilnehmer:innen erméglicht.

Daneben ist es auch moglich, das Erreichen eines bestimmten Levels als
,Voraussetzung” (siehe dazu auch das Kapitel ,,Flr Trainer:innen: Konfigurieren
eines Kurses”) zu definieren oder festlegen, dass ein:e Kursteilnehmer:in
automatisch in Kurs B eingeschrieben wird, sobald er bzw. sie in Kurs A ein
bestimmtes Level erreicht hat.

Level Up XP fungiert damit fir die Trainer:innen als erganzendes Werkzeug, um
Aktivitat und Fortschritt der Kursteilnehmer:innen im Kursverlauf sichtbar zu
machen.

Fortschritt

100%

67%

89%

4%

100%
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Fiir Trainer:innen:
Rund um die Kursteilnehmer:innen

Einschreibemethoden im Kurs verwalten

Es gibt verschiedene Méglichkeiten, Teilnehmer:innen in Ihren Kurs einzuschreiben —einen Uberblick dazu finden
Sie hier.

Hinweis: Damit eine Einschreibemethode in einem Kurs zum Einsatz kommen kann, muss diese zunachst

systemweit durch den:die jeweilige:n Administrator:in aktiviert werden (siehe dazu das Kapitel ,Fir
Administrator:innen: User und Registrierung”).

Daneben muss der:die Trainer:in die gewlinschte Einschreibemethode normalerweise auch direkt im Kurs
aktivieren. Rufen Sie dazu den gewinschten Kurs auf und klicken Sie in der Navigationsleiste auf
,Teilnehmer/innen”. AnschlieRend 6ffnet sich iber einen Klick auf , Eingeschriebene Nutzer/innen” oben links
ein Dropdown-Mend, in dem der Punkt ,,Einschreibemethoden” ausgewahlt werden kann:

Demo-Kurs

Einstellungen

| Eingeschriebene Nutzer/innen u|

~  Eingeschrichene Nutzer/innen
Einschreibemethoden ® °

Umbenennen der Rolle

Gruppen

Nutzer/finnen einschreiben

Gruppierungen
Uberblick H % W Inlolrlalrls|T

Sie gelangen zu einer Ubersicht der verfiigbaren Einschreibemethoden.

Falls das Auge neben der jeweiligen Einschreibemethode durchgestrichen dargestellt ist (wie im Screenshot
unten beim , Gastzugang” und der ,Selbsteinschreibung (Teilnehmer/in)“), ist die Einschreibemethode im Kurs
nicht aktiviert. Per Klick auf das durchgestrichene Auge erfolgt die Aktivierung:

Einschreibemethoden -

Name Nutzer/innen  Aufwirts/Abwirts Bearbeiten
Manuelle Einschreibung 1 ¥ goars
5astzugang 0 T3 R/
Selbsteinschreibung (Teilnehmer/in; 0 L IR/

Methode hinzufuger] Auswahlen ...

Auswadhlen ...

Selbsteinschreibung
Globale Gruppe

Level Einschreibung

In obigem Beispiel konnte im betreffenden Kurs grundsatzlich auch eine Einschreibung tiber ,,Globale Gruppen®,
die ,Selbsteinschreibung” fiir andere Rollen oder die Einschreibung (ber die liber LevelUp XP erreichten Level
der Teilnehmer:innen im Kurs genutzt werden. Dazu die jeweilige Methode einfach im Dropdown anklicken.

Uber den Stift ganz rechts neben den jeweiligen Einschreibemethoden gelangen Sie zu den Einstellungen. Hier
kdnnen Sie u. a. die Standardrolle fir die jeweiligen Benutzer:innen setzen, Einschreibeschlissel festlegen oder
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definieren, ob die Dauer der Einschreibung beschrédnkt sein soll. Die konkreten Optionen unterscheiden sich hier
je nach Einschreibemethode.

Einige ausgewadhlte Einschreibemethoden werden in der Folge kurz vorgestellt.

Manuelle Einschreibung
Klicken Sie, um Teilnehmer:innen manuell in einen Kurs einzuschreiben, in der Navigationsleiste des

betreffenden Kurses auf , Teilnehmer/innen” und anschlieBend auf den Button , Nutzer/innen einschreiben:

Demo-Kurs

Kurs  Einstellungen

Finde | Retitin ¢ | [ aucwan s a

Im Anschluss kénnen Sie im Suchfeld (Ziffer 1) nach den entsprechenden Usern suchen. Wahlen Sie bei ,,Kursrolle
zuweisen” (Ziffer 2) die Rolle ,Teilnehmer/in“ aus und bestatigen Sie im Anschluss mit Klick auf ,,Nutzer/innen
und globale Gruppen einschreiben”.

Nutzer/innen einschreiben X

Einschreibeoptionen

Nutzer/finnen (x — _] o
Suchen v

Globale Gruppen Keine Auswahl

auswahlen
Suchen v

Kursrolle zuweisen Teilmehmer/in + °

Mehr anzeigen ...

YTV Nutzer/innen und globale Gruppen einschreiben

Auf dieselbe Weise konnen Sie auch weitere Trainer:innen im Kurs eintragen — wahlen Sie in diesem Fall beim
Dropdown-Men , Kursrolle zuweisen” einfach bzw. , Trainer/in“ aus.

Selbsteinschreibung in Kurse erlauben

Die Selbsteinschreibung ermoglicht es Nutzer:innen lhrer Instanz, sich eigenstandig in Kurse einzuschreiben. Sie
kann eingesetzt werden, wenn ein Kurs fiir ein gréf3eres Publikum zuganglich gemacht werden soll bzw. wenn
ein Zugriff auf Lerninhalte ohne aktives Eingreifen seitens Trainer:in moglich sein soll.

Mochte sich nun ein:e Benutzer:in selbst in den Kurs eintragen, sieht dies folgendermalien aus:

Demo-Kurs

Einschreibeoptionen

ll Teacher: Hannes Lehrer

v Selbsteinschreibung (Student)

Kein Einschreibekennwort notwendig
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Wurde ein Einschreibeschlissel festgelegt, ist dieser an dieser Stelle einzutragen, bevor der Kurs aufgerufen
werden kann.

Unter diesem Link finden Sie weitere Informationen zum Thema Selbsteinschreibung.

Gastzugriff erlauben

Der Gastzugang erlaubt es Nutzer:innen, einen Kurs ohne Anmeldung oder Einschreibung zu betreten. Diese
Methode eignet sich besonders fiir 6ffentliche Kurse, Schnupperangebote oder Inhalte, die frei zuganglich sein
sollen. Zu beachten ist allerdings, dass Gaste standardmaRig nicht an Aktivitdten in einem Kurs teilnehmen
kénnen!

Wenn gewilinscht, kdnnen Sie im Zuge der Aktivierung des Gastzugangs in lhrem Kurs einen so genannten
»,Gastschllssel” festlegen — ein ,,Passwort”, ohne das der Zugriff flir Gaste auf lhren Kurs nicht moglich ist. Damit
kénnen Sie sehr niedrigschwelligen Zugang zu Lerninhalten ermdoglichen.

Nahere Informationen finden Sie auch hier sowie im Kapitel ,,Fir Administrator:innen: User und Registrierung”.

Einschreibung tber Globale Gruppen

Die Einschreibemethode , Globale Gruppen® kann eingesetzt werden, um beispielsweise eine ganze Klasse oder
Seminargruppe einfach in einen Kurs einzuschreiben. Sie hat den groBen Vorteil, dass Anderungen an der
Globalen Gruppe (z. B. wenn Mitglieder hinzukommen oder wegfallen) direkt im jeweiligen Kurs greifen.

Hinweis: Die Globalen Gruppen miissen im Vorfeld durch den:die Administrator:in bzw. den:die Manager:in
angelegt werden, damit sie fur die Einschreibung zur Verfligung stehen.

Ndhere Informationen sind hier zusammengestellt.

Globale Gruppen — Gruppen — Gruppierungen

Auf lhrer Instanz gibt es verschiedene Moglichkeiten, Nutzer:innen zu gruppieren: Man unterscheidet ,,Globale
Gruppen” (engl. ,Cohorts”), ,,Gruppen” (engl. ,Groups“) und ,,Gruppierungen” (engl. ,Groupings®).
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Globale Gruppen

Eine ,Globale Gruppe” bezieht sich immer auf eine komplette Instanz oder einen Kurs(unter)bereich. lhr
Hauptzweck ist es, die einfache Einschreibung einer fixen Personengruppe (z. B. einer Klasse) in einen Kurs zu
ermoglichen. Globale Gruppen kdnnen von Administrator:innen bzw. Manager:innen angelegt werden.

N&here Informationen finden Sie hier.

Gruppen

Mit Hilfe der , Gruppen“-Funktionalitdt kénnen in einem Kurs oder auch auf Ebene einzelner Aktivitdaten
Gruppenarbeiten in Ihrer Instanz umgesetzt werden. Dabei kann festgelegt werden, ob die Mitglieder einer
Gruppe ausschlieRlich die Personen in der eigenen Gruppe und deren Aktivitdten im Kurs sehen kdnnen sollen
oder ob auch eine Lesezugriff auf die Aktivitdten der anderen Gruppen moglich sein soll.

Das Anlegen von Gruppen erfolgt tiblicherweise durch den:die jeweilige:n Trainer:in.

Rufen Sie dazu den gewiinschten Kurs auf und klicken Sie in der Navigationsleiste auf , Teilnehmer/innen”.
AnschlieRend 6ffnet sich iber einen Klick auf , Eingeschriebene Nutzer/innen” oben links ein Dropdown-Mend,
in dem der Punkt ,Gruppen” ausgewahlt werden kann:

Demo-Kurs
Kus  Enstellungen Bewertungen  Berichte  Mehr~

| Eingeschriebene Nutzer/innen ~|

Nutzer/innen einschreiben

Einschreibung

v Eingeschricbene Nutzer/innen
Einschreibemethoden = °
Umbenennen der Rolle
Gruppen

Gruppierungen
Uberblick

Rechte

Sie sehen nun zwei leere Spalten vor sich: In der linken Spalte werden spater die einzelnen Gruppen aufgelistet
und in der rechten Spalte jene Teilnehmer:innen, die sich in dieser Gruppe befinden.

Klicken Sie auf ,Gruppe anlegen”, um manuell eine Gruppe zu generieren — Sie werden nun aufgefordert, einen
Gruppennamen zu vergeben und konnen die Gruppe auch kurz beschreiben.

Gruppen konnen optional mit einem Einschreibeschlissel versehen werden, damit Teilnehmer:innen beim
Einschreiben in einen Kurs gleich automatisch der richtigen Gruppe zugeordnet werden. Darliber hinaus kdnnen
Sie hier u. a. auch definieren, ob die Gruppenmitglieder sich gegenseitig Nachrichten schicken diirfen. Speichern
Sie lhre Angaben.

Erstellen Sie nun so viele Gruppen, wie Sie benétigen. In der

Demo-Kurs
linken Spalte sehen Sie, wie viele Gruppen Sie bereits angelegt e o it s
haben und wie viele Mitglieder diese jeweils haben. Sie konnen cruppen
einer Gruppe Mitglieder zuweisen, indem Sie die jeweiligen e e
Gruppennamen in der linken Spalte markieren und
anschlieBend unterhalb der rechten Spalte auf ,,Nutzer/innen
verwalten” klicken.
Eine Liste aller Teilnehmer:innen aus lhrem Kurs wird nun
angezeigt. Markieren Sie nun die gewlnschten Personen,
welche in die Gruppe hinzugefiigt werden sollen. Mit einer Zahl "ji':f.'jmi'fgewsh"e" e
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hinter jedem Namen wird lhnen angezeigt, ob und in wie vielen Gruppen diese Person schon ist. Klicken Sie auf
,Hinzufliigen”, um den Vorgang abzuschlieRen. Klicken Sie nun auf eine Gruppe der linken Spalte, werden die
Gruppenmitglieder rechts aufgelistet.

Alternativ zur manuellen Erstellung von Gruppen haben Sie auch die Mdglichkeit, automatische Gruppen
generieren zu lassen. Klicken Sie hierzu auf den Button ,,Gruppen automatisch anlegen”: AnschlieRend kénnen
Sie die gewilinschte Anzahl der Gruppen bzw. die GruppengréRe ebenso festlegen wie die Rollen der
Gruppenmitglieder oder wie deren Zuordnung zu den Gruppen erfolgen soll.

N&here Informationen zum Thema Gruppen finden Sie auch hier.

Gruppierungen

Gruppierungen dienen dazu, um Gruppen zusammenzufassen, beispielsweise, wenn mehrere Gruppen in
unterschiedlichen Konstellationen an einer Aufgabe arbeiten sollen. Eine Gruppe kann Teil mehrerer
Gruppierungen sein.

Gruppierungen werden ebenfalls durch den:die jeweilige:n Trainer:in angelegt. Klicken Sie dazu in der
Navigationsleiste des jeweiligen Kurses auf , Teilnehmer/innen” und anschlieRend im Dropdown-Menii links auf
,Gruppierungen”:

Demo-Kurs

v Eingeschriebene Nutzer/innen

Enscheibemetnoden . -]

Usibenenreen des Rolle

[EETT O Fiver anwenvden

Uber den Button ,,Gruppierung anlegen kénnen Sie eine neue Gruppierung erstellen und anschlieBend mit Klick
auf das markierte Symbol Gruppen in Ihre Gruppierung hinzufigen:

Demo-Kurs

Einstellungen  Teilnehmerfinnen  Bewertungen  Berichte  Mehr

Gruppierungen -

Gruppierung Gruppen Aktivititen  Bearbeiten
Gruppierung 1 Keine 0 Fa

Gruppierung anlegen

Nahere Informationen finden Sie hier.

Bewertungen

Eng mit E-Learning verknipft ist natlrlich auch die Frage nach der Ermittlung und Dokumentation der Leistungen
von Lernenden: |hre Instanz bietet eine Fille von Einstellungsmoglichkeiten rund um die Bewertung — einige
davon sind auf Systemebene durch den:die jeweilige:n Administrator:in vorzunehmen (siehe dazu auch hier), die
meisten erfolgen allerdings direkt durch die jeweiligen Trainer:innen. Einen vollstindigen Uberblick tber alle
verfligbaren Konfigurationsmdglichkeiten finden Sie hier.

v
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Auf lhrer Instanz kdnnen einerseits Trainer:innen die Leistungen ihrer Kursteilnehmer:innen tbersichtlich in einer
Bewertungsiibersicht abrufen; andererseits erhalten auch die Kursteilnehmer:innen selbst einen Uberblick tiber
den Status Quo.

Bei einigen Aktivitaten gibt es standardmaRig Bewertungen (z. B. bei Tests), es gibt aber auch die Maoglichkeit,
zusatzlich auch andere Aktivitaten (beispielsweise Foren) mit Bewertungen zu versehen. Trainer:innen kénnen
die Bewertungsibersicht dann direkt Gber die Navigationsleiste im Kurs und den Punkt ,Bewertungen” aufrufen:

Bewertungsiibersicht . . . Mach Name fitern - Emgekiapate Sositen ©

Demo-Kurs =

® |
3

Gessamtdumchacheitt

Per Klick auf die drei Punkte neben dem Namen kdnnen sie einerseits die ,,Einzelansicht” fir die jeweilige Person,
andererseits den so genannten ,Nutzerbericht” aufrufen:

AM Andrea Muster  eee

. Einzelansicht fur diese Person

Nutzerbericht

In der ,Einzelansicht” kénnen Sie direkt auf die einzelnen bewerteten Aktivitdten zugreifen und damit die
Detailansicht der Bewertungen fir eine:n bestimmte:n Nutzer:in abrufen:

Demo-Kurs

Einzelansicht - Andres Muste x her ANZEIGEN NACH ewertungsaspekte
AM  Andrea Muster ®

Name der Bewertung Bewertungskategorie Bewertung Bereich Feedback  Oberschreiben  AusschiicBien

® 4isp.Oving = Demo-Kurs 3 w000 10000

T Kurs gesamt

Wiahlen Sie den Punkt ,Nutzerbericht” aus, 6ffnet sich die so genannte ,,Ubersicht fiir Teilnehmer/in“ — diese
Ansicht kann auch von dem:der jeweiligen Kursteilnehmer:in selbst aufgerufen werden. Dort finden sich u. a.
auch die Gewichtungen der verschiedenen Teilaspekte eines Kurses, aus denen sich die Bewertung
zusammensetzt:
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Ubersicht fiir Teilnehmer/in - Ancies Musies * ociscvig

AM  Andrea Muster W =

Bewertungsaspet Berechnete Gewichtung Bewertung  Bersich  Promontsats  Fredback  Betrage sum Kurs gessmt

 Dema-Kurs

62% 10000 o100 w00n% s
o1 ace%

000 %

Bewertungen konnen entweder direkt in der dazugehdrigen Aktivitat (in diesem Fall werden sie automatisch in
die Bewertungsiibersicht libernommen) oder auch direkt in der Bewertungsiibersicht des Kurses bzw. der
Einzelansicht vorgenommen werden. In letzteren beiden Fallen muss der ,Bearbeiten“-Modus aktiviert sein.
N&here Informationen dazu finden Sie auch hier.

Ermittlung der Gesamtbewertung eines Kurses

StandardmaRig werden alle Bewertungen innerhalb eines Kurses zusammengefasst und daraus eine Gesamtnote
ermittelt. Es gibt verschiedene Mdoglichkeiten, wie diese Gesamtbewertung ermittelt werden kann: angefangen
von einem bloRen Durchschnittswert tber die Miteinbeziehung von Gewichtungen bis hin zum Median oder
einfach der Summe aller Bewertungen.

Sie als Trainer:in kdnnen die gewiinschte Methode einstellen, indem Sie in der Navigationsleiste des Kurses auf
den Punkt , Bewertungen” klicken und im Dropdown-Menti links den Punkt ,,Setup fur Bewertungen“ auswahlen:

Demo-Kurs

Kurs  Einstelungen  Teilnehmerfinnen  Bewertungen  Berichte  Mehr

Bewertungsiibersicht - Nutzer/innen suchen Nach Name filtern ~

~  Bewertungsiibersicht
Bewertungsverlauf Demo-Kurs

Ubersicht
Einzelansicht H5P-Obung = [ Quiz

Bewertungsbericht

Ubersicht far Teilnehmer/in ®gmaile
Konfiguration

Einstellungen zur Kursbewertung

Grundeinstellungen: Bewertungsibersicht e

Bawarninaeckslan. vom.de 000 -

Klicken Sie anschlieRend auf die drei Punkte rechts neben dem Namen lhres Kurses und auf den Punkt ,Kategorie

bearbeiten”:

Beste
Name Bewertung Status Aktionen
Einfach gewichteter Durchschnitt
v Demo-Kurs Leere Bewertungen ausnehmen @
Kategorie bearbeiten |
e H5P-Ubung 100,00 Verbergen
Sperren

In der darauffolgenden Ansicht kénnen Sie unter ,Gesamtergebnis” auswahlen, welche Methode fir die
Ermittlung der Gesamtbewertung herangezogen werden soll. Ndhere Informationen hierzu finden Sie auch hier.
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Kategorie bearbeiten

PUCET speichern

Bewertungsskalen anlegen

lhre Instanz bietet nicht nur die Moglichkeit, in der Bewertung von Aktivitdten mit einer Punkteskala von 0 bis
100 zu arbeiten, sondern auch verbale Skalen einzusetzen. Diese Skalen sind (mit Ausnahme einer Basisskala) in
einer neuen Installation noch nicht vorhanden und kénnen standardmaRig direkt im Kurs von lhnen als Trainer:in
erstellt werden.

Gehen Sie dazu in der Navigationsleiste Ihres Kurses auf ,Bewertungen”, und wéahlen Sie im Anschluss im
Dropdown-Menii ,,Bewertungsskalen” aus:

Demo-Kurs

Kurs  Einstelungen  Teilnehmerfinnen  Bewertungen  Berichte  Mehr~

Bewertungsiibersicht - Nutzer/innen suchen Nach Name filtern -

¥ Bewertungsiibersicht
Bewertungsverlauf

Ubersicht

Demo-Kurs

i HSP- B Quiz
Einzelansicht ® HSP-Ubung E Qui

Bewertungsbericht

Ubersicht fiir Teilnehmer/in @agmail
Setup fur Bewertungen L
Einsteflungen zur Kursbewertung
Grundeinstellungen: Bewertungsdbersicht  fe
Mehr

Klicken Sie anschliefend auf den Button ,Neue Bewertungsskala anlegen”, um eine neue Skala zu erstellen.
Wenn Sie entsprechende Rechte besitzen und beim Punkt ,Standard-Bewertungsskala” ein Hakerl setzen, steht
die jeweilige Skala nicht nur im Kurs, sondern auf der gesamten Instanz zur Verfiigung.

Im Bereich ,Bewertungsskala“ werden die Werte der Skala mit Komma voneinander getrennt eingegeben. Bitte
beachten Sie, dass hier mit dem niedrigsten/schlechtesten Wert begonnen werden muss.
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Skala hinzufiigen
v Bewertungsskala
Name o Hotenskala

Sundsrd-Bewertungssials @
Bewertungsskala © @ | nicht genigend, genagend, befriedigend, gut, sehr gut

Beschreibung

3 A B I == %% o wE RS -

Diese Skala it angelehnt an die Kiassischen Schulnoten

Abbrechen

Die Skala kann eingesetzt werden, indem sie in den Einstellungen einer Aktivitat im Abschnitt ,Bewertung”
ausgewahlt wird:

v Bewertung

Bewertung [7]

Typl. Skala * |

Skali Kein

\ ZiSkaIa I

Punkt

Bewertungsmethod @ | Einfache direkte Bewertung + |

Sobald die Skala in einer Aktivitat ausgewahlt wurde, kann diese nicht mehr gedndert oder geldscht werden.

Nédhere Informationen rund um Skalen finden Sie auch hier.

Fragensammlung

Die Fragensammlung bietet die Moglichkeit, Fragen zu erstellen, zu bearbeiten und zu organisieren, die in
Aktivitdten wie z. B. Tests zum Einsatz kommen kdénnen.

Der Aufruf der Fragensammlung erfolgt Gber die Navigationsleiste des jeweiligen Kurses und den Punkt ,,Mehr >
Fragensammlung®:

Demo-Kurs

Kurs  Einstellungen  Teilnehmer/innen  Bewertungen  Berichte  Mehrv

Fragensammlung

Inhaltsspeicher

Kursabschluss

I Admin-Kurs

B N N B Badi
Dieser Kurs ist fir die Arbeit der Admins gedacht - hier finden sich Mdglichkeiten z adges

und vnr allam inear Dakumantatinnetanll

lien
Komnetenzen

Die Fragen werden zentral verwaltet — die Speicherung der Fragen erfolgt hierarchisch strukturiert, also in
Kategorien, die wiederum Unterkategorien enthalten konnen. Aufgrund des ausgekliigelten dahinterliegenden

Rechtesystems kann sehr detailliert festgelegt werden, welche Fragen wo fir wen verfiigbar sind. Man
unterscheidet hier so genannte Fragenkontexte:

e  Aktivititen-Kontext: enthalt Fragen, die nur innerhalb der Aktivitat verfigbar sind
e  Kurs-Kontext: enthdlt Fragen, die in allen Aktivitaten des Kurses verfligbar sind
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o  Kursbereich-Kontext: enthélt Fragen, die in allen Aktivitdten in allen Kursen des Kursbereichs verfiigbar
sind

e System-Kontext: enthalt Fragen, die in allen Kursen und allen Aktivitdten der Instanz verflgbar sind
Allerdings missen hierbei zwei Dinge beachtet werden:

Einerseits kdnnen Sie nur dort Fragen anlegen, wo Sie auch Uber die entsprechenden Rechte verfligen (im Falle
eines Trainers/einer Trainerin also normalerweise im Aktivitats- bzw. Kurs-Kontext, aber nicht im Kursbereichs-
oder System-Kontext).

Andererseits hangen die zur Verfligung stehenden Kontexte auch davon ab, von wo aus Sie die Fragen erstellen
mochten: Fragen in einem Aktivitats-Kontext kdnnen auch nur tatsachlich von der jeweiligen Aktivitat aus erstellt
werden; legen Sie die Fragen von der Hauptseite eines Kurses aus an, sind diese auch im gesamten Kurs
verflgbar.

Hinweis: Wenn Trainer:innen die Mdoglichkeit haben sollen, untereinander Fragen auszutauschen, ist hierfiir das
Setzen der entsprechenden Rechte durch den:die Adminstrator:in notwendig. Informationen hierzu finden Sie
hier.

Anlegen von Kategorien

StandardmaRig gibt es in jedem Kurs eine Fragenkategorie
namens ,Standard”. Sie konnen aber dariiber hinaus
zusatzliche bzw. Unterkategorien anlegen, um die Fragen in oo T
der Fragensammlung besser verwalten zu kénnen. Gehen Sie

hierfr in der Navigationsleiste lhres Kurses auf ,Mehr > Kategorien bearbeitene

Fragensammlung” und wahlen Sie im Dropdown-Men links o
Fragenkategorien fiir ‘Kurs: Demo-Kurs'

oben ,Kategorien” aus. Sie sehen eine Ubersicht der
Kontexte, in denen Sie Fragekategorien anlegen kdnnen, o S e @
sowie der bereits vorhandenen Kategorien und kénnen tber H  Intemetsicherhes 0
den entsprechenden Button eine Maske zum Anlegen neuer 3 Pt ©

Kategorien aufrufen.

& Als Moodle-XML exportieren

Die hier verfligbaren Optionen sind abhdngig von den
Rechten, die Sie auf der Instanz besitzen — in diesem Beispiel handelt es sich um einen Standard-Trainer:innen-
Account, der im Kurskontext die Rechte zum Anlegen von Kategorien besitzt.

Beim Ausfiillen der Eingabemaske kdnnen Sie auswahlen, in welcher tibergeordneten Kategorie die neu erstellte
Kategorie angesiedelt sein soll; per Drag & Drop bzw. Gber das Dreipunkt-Meni kénnen Sie die Kategorien
verschieben oder im Nachhinein bearbeiten. Nahere Informationen finden Sie dazu auch hier.

Anlegen von Fragen
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Das Anlegen von Fragen funktioniert ganz dhnlich wie das

Erstellen von Kategorien in lhrer Fragensammlung: Gehen Pemo-Kurs

Sie in der Navigationsleiste lhres Kurses auf ,Mehr > e
Fragensammlung” und klicken Sie im Dropdown-Meni links

auf ,Fragen”. Fragensammlung

Anschliefend kdnnen Sie die Kategorie auswahlen, in der "qu Engeben ager auswatienX
lhre Frage angelegt werden soll. Grundsatzlich wird die oo Kurs: demars
Fragenkategorie ,Standard” verwendet (siehe rote e Voo anicon s | st
Markierung);  Sie  kdnnen  aber auch andere +  sedigung hautigen M

Neue Frage erstellen.. l Spalten zurocksetzen || Fragetext in der Frageliste anzeigen? | Nein M

Fragenkategorien verwenden. Dazu einfach in der
Mit Auswahl =

Suchmaske die Kategorie via Dropdown auswahlen oder
den Namen der Kategorie in der Maske eingeben.

Die hier verfligbaren Optionen sind abhangig von den Rechten, die Sie auf der Instanz besitzen — in obigem
Beispiel handelt es sich um einen Standard-Trainer:innen-Account, der im Kurskontext die Rechte zum Anlegen
von Fragen besitzt.

Klicken Sie anschlieBend auf den Button ,Neue Frage erstellen...” — Sie gelangen zur Auswahl der verschiedenen

Fragetypen:
Markieren Sie den gewtinschten Fragetyp x
R
FRAGEN Wahlen Sie inen Fragetyp, um seine
O 32 Multiple-Choice Beschreibung zu sehen,
O »+  WahyFalsch

| O = Kuzantwert
O &5 Mumerisch
37 Berechnet
| O [ Freitext
| O i Zuordnung

s Zufslige
* Kurzantwertzuordnung

o]
H

"% Luckentext (Cloze)

O
i

Algebra

Alles-oder-nichts
Multiple Choice

w

|u

Die grundlegenden Einstellungen sind bei fast allen Fragentypen gleich: Zu Beginn wird der ,Fragetite
eingegeben — dieser kann auch schon die eigentliche Frage sein und dient zur Verwaltung der Fragen in der
Fragensammlung.

Ist die Frage langer, so wird diese im Feld ,Fragetext” festgehalten. Bei ,Fragestatus” konnen Sie (wenn
gewlinscht) definieren, dass die jeweilige Frage sich noch im Entwurfsstatus befindet. Unter ,Erreichbare
Punkte” wird festgelegt, wie viele Punkte fir die richtige Beantwortung der Frage vergeben werden sollen.

Das , Allgemeine Feedback” ist der Text, der nach der Beantwortung einer Frage angezeigt wird (z. B. Vielen Dank
fur deine Antwort!). Anders als das Feedback, das vom Fragentyp und der Antwort des Teilnehmers bzw. der
Teilnehmerin abhdngt, wird der Text des Standard-Feedbacks allen Antwortenden gezeigt.

Ndhere Informationen zum Anlegen von Fragen finden Sie hier; Details dazu, wie die Felder der Eingabemaske
bei den einzelnen Fragetypen beflllt werden sollen, finden Sie im Kapitel ,Fragetypen”. Dort ist fiir jede Frageart
eine passende Anleitung verlinkt.
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Hinweis: Neben dem Anlegen von Fragen direkt in der Instanz ist es auch moglich, diese zu importieren bzw.
etwa aus einer anderen Instanz zu exportieren und so in die eigene Instanz zu bringen. Informationen dazu finden
Sie hier: Import von Fragen bzw. Export von Fragen.

Fragetypen

Auf hrer Lernplattform stehen folgende Fragetypen zur Verfligung:

e Algebra
Die Kursteilnehmer:innen mussen Fragen dieses Typs in Form einer Algebra-Formel beantworten. Die
Antwort wird auf Basis algebraischer Regeln mit der vom Kursleiter bzw. der Kursleiterin angegebenen
richtigen Antwort verglichen und so evaluiert.
Beispielfrage:
Geben Sie die erste Ableitung der folgenden Funktion an: flz) = 32° — 527 + 4z — 1

e Anordnung
Werden Fragen von diesem Typ eingesetzt, werden den Kursteilnehmer:innen Wérter, Wortgruppen oder
Bilder in zufalliger Reihenfolge angezeigt, die richtig angeordnet werden mussen.
Beispielfrage:

Sortieren Sie die folgenden Stddte von Nord nach Siid!

e Berechnet

Dieser Fragentyp erlaubt es, eine Vielzahl von verschiedenen gleichartigen Aufgaben zu erstellen. Sie basieren
auf einer Formel mit zumindest einer Variablen, die mit zufallig generierten Zahlen aus einem Zahlenbereich
befillt wird. Bei diesem Fragentyp konnen zahlreiche Einstellungen vorgenommen werden, z. B. ob
MaReinheiten angegeben werden miissen und bewertet werden.

Der Fragentyp , Einfach berechnet” verfiigt Gber die wichtigsten Funktionalitaten dieses Fragentyps, ist aber
einfacher anzulegen und zu konfigurieren. Auch der Fragentyp ,, Berechnete Multiple-Choice” ist mit diesem
Fragentyp verwandt: Hier enthalten die zur Verfiigung stehenden Antwortmaoglichkeiten Formeln, die mit
den zufallig generierten Variablen erganzt werden.

Beispielfrage:

Berechne den Fldcheninhalt eines Rechtecks mit der Ldnge {I} m und der Breite {b} m.

Fir jede:n Kursteilnehmer:in werden in der Frage die Werte fiir Ldnge und Breite durch zuféllige Werte
ersetzt; die Auswertung der Antwort erfolgt auf Basis der Formel fir den Flacheninhalt {I}x{b}.

e Drag-and-Drop-Fragen
Wird dieser Fragentyp eingesetzt, konnen die Kursteilnehmer:innen Textbausteine oder Bilder aus einer Liste
an zuvor definierte ,,Dropzones” ziehen.
Die Dropzones kdonnen hier vordefinierte Stellen eines Bildes (Drag-and-Drop auf Bild bzw. Drag-and-Drop
Markierungen) oder auch Liicken in einem Text sein (Drag-and-Drop auf Text).
Beispielfrage:
Ordnen Sie die Bezeichnungen der Knochen der Abbildung des Skelettes zu, indem Sie die richtigen
Begriffe per Drag and Drop an die richtige Stelle ziehen.

e GeoGebra
Bei diesem Fragetyp wird ein GeoGebra Applet fiir die Fragestellung herangezogen.

e  Freitext
Freitextfragen erfordern die freie Formulierung einer Antwort oder den Upload einer oder mehrerer Dateien.
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Der wesentliche Unterschied zu den anderen Fragetypen besteht darin, dass die Bewertung der Antwort
manuell durch den:die Trainer:in erfolgen muss. Daher erhalten Kursteilnehmer:innen die Bewertung nicht
direkt im Anschluss an die Absolvierung des Tests.

Beispielfrage:

Verfassen Sie einen Leserbrief zu einem aktuellen Thema Ihrer Wahl. Beachten Sie dabei die typische

Form dieser Textart wie im Unterricht besprochen!

e  Kurzantwort
Dieser Fragentyp ist vor allem dann sinnvoll, wenn Sie einzelne gelernte Informationen abfragen mochten.
Die Antwort besteht aus einem einzelnen Wort oder einer Wortgruppe und muss mit einer der zuvor
definierten moglichen Antworten exakt Gbereinstimmen.

Beispielfrage:

In welchem Bundesland liegt Linz?

e  Liickentext
Bei diesem Fragentyp arbeiten die Kursteilnehmer:innen mit einem Text in einem speziellen Format, in dem
sie verschiedene Fragen beantworten missen. Die Fragen sind in den Text integriert — es kann sich hier um
Multiple-Choice-Fragen, Fragen vom Typ Kurzantwort oder numerische Fragen handeln. Die Fragen missen
einem speziellen Format folgen und konnen entweder direkt im Textfeld der Frage eingegeben oder aus einer
vorab erstellten Textdatei importiert werden.

e Liickentextauswahl

Lickentextauswahl-Fragen sind sehr dhnlich zu Fragen des Typs Drag-and-Drop auf Text. Der Unterschied
liegt hier damit, dass mit Dropdown-Meniis anstelle von ziehbaren Elementen gearbeitet wird. Daher eignet
sich dieser Fragentyp vor allem bei der Verwendung langer Texte. Sehr praktisch ist die Funktion, die zur
Verfligung stehenden Auswahlmoglichkeiten zu Kategorien (Gruppen) zusammenzufassen, sodass nur
Antworten einer Kategorie (z. B. Knochen, Muskeln ...) als mogliche Optionen zur Verfligung stehen.

e Multinumerisch
Dieser Fragentyp erlaubt den Einsatz von Aufgaben, bei denen Gleichungen oder Ungleichungen mit
mehreren richtigen Ergebnissen abgefragt werden.
Beispielfrage:
Geben Sie Werte fiir X, Y und Z ein, sodass die folgenden Bedingungen erfiillt sind:
1. X+Y+2>12
2. X-Ys<3
3. Zliegt zwischen 0 und (inklusive) 100

e  Multiple-Choice
Multiple-Choice-Fragen kdnnen in Tests sehr flexibel verwendet werden: So kdnnen eine oder mehrere

Antworten als richtig zahlen, es kdnnen in Fragen oder Antworten Bilder oder Multimedia-Elemente
eingebunden werden oder Sie kdnnen die verschiedenen Antwortoptionen gewichten. Ebenso kann definiert
werden, ob die Kursteilnehmer:innen eine oder mehrere Antwortoptionen auswéahlen kénnen.

Eine Abwandlung der klassischen Multiple-Choice-Frage ist der Fragentyp ,Alles-oder-nichts Multiple

Choice”. Der Unterschied liegt hier darin, dass die Frage mit 100 % bewertet wird, wenn der User exakt die
richtigen Antwortoptionen ausgewahlt wird. Werden allerdings nicht alle richtigen Antworten oder eine
falsche Option gewahlt, wird die Frage mit 0% bewertet.

e Numerisch
Numerische Fragen sehen aus Sicht der Kursteilnehmer:innen wie Kurzantwort-Fragen aus. Der Unterschied
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zur Kurzantwort besteht allerdings darin, dass die Antwort aus einer Zahl besteht und ein Toleranzintervall
festgelegt werden kann. Ist die Antwort beispielsweise 20 und der akzeptierte Fehler 5, so gelten alle
Antworten zwischen 15 und 25 als richtig.

Wie bei berechneten Fragen kann auch hier festgelegt werden, ob MaReinheiten angegeben werden missen
bzw. ob sie in die Bewertung mit einbezogen werden.

e STACK
STACK ermoglicht den Einsatz mathematischer Fragestellungen in Tests. Es arbeitet dabei mit einem
Computeralgebrasystem, um mathematische Eigenschaften der eingegebenen Antworten zu ermitteln und
diese dann zu bewerten.

e  Wahr/Falsch

Bei diesem Fragentyp stehen den Kursteilnehmer:innen nur die Antwortoptionen ,,Wahr” oder ,Falsch” zur
Verfligung. Im Fragetext konnen Bilder oder HTML-Code eingebaut werden.

e  Zuordnung
Zuordnungsfragen bestehen aus einem Fragentext und zwei Listen mit Elementen, die einander zugeordnet

werden missen.

Beispielfrage:

Ordnen Sie den Léndern die jeweiligen Hauptstédte zu!
mit den beiden Listen "Osterreich, Spanien, Peru" und "Wien, Madrid, Lima"

Mit Zuordnungsfragen ist der Fragentyp ,Zuféllige Kurzantwortzuordnung” verwandt. Der Unterschied liegt

darin, dass die Fragen und Antworten zufallig aus dem Pool der Kurzantwortfragen der jeweiligen Kategorie
gezogen werden. Die Auswahlmdglichkeiten, die die Kursteilnehmer:innen den einzelnen Teilfragen
zuordnen missen, kommen aus der Menge der richtigen Antworten. Daher empfiehlt es sich, diesen
Fragentyp nur einzusetzen, wenn in einer Fragenkategorie ausschlieflich Fragen aus demselben
Themenbereich (z. B. Hauptstdadte) enthalten sind.

Eine Erweiterung der Zuordnungsfrage stellt der Fragentyp , Drag-and-Drop-Zuordnung” dar, bei dem die zur

Verfugung stehenden Antworten auf ihr passendes Gegenstlick gezogen werden mussen.

e Beschreibung
Neben den beschriebenen Fragetypen wird beim Anlegen von Testfragen auch die Option ,,Beschreibung”

angeboten.
Dieser Inhaltstyp dient dazu, eine Information anzuzeigen und kann beispielsweise eingesetzt werden, wenn
Sie eine Info geben mdchten, auf welche sich z. B. die nachfolgenden fiinf Fragen beziehen.

Der Zugriff auf die Fragensammlung erfolgt wiederum Uber die Navigationsleiste im Kurs: Klicken Sie auf ,,Mehr
> Fragensammlung”, und wahlen Sie anschliefend im Dropdown-Meni die Kategorie der Fragen aus, die Sie
aufrufen moéchten. Klicken Sie anschlieRend auf ,Filter anwenden®, um die entsprechenden Fragen zu laden.

StandardmaéRig werden folgende Spalten angezeigt:
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# Frage bearbeiten

& Dupl
.
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@ Loschen
E Verauf

& s Moodie XML exporteren
Fragentyp: Das rot markierte Symbol zeigt an, um welchen Fragentyp es sich bei der jeweiligen Frage
handelt — in diesem Beispiel handelt es sich um eine Multiple-Choice-Frage.

Frage: In dieser Spalte findet sich der Fragentitel — er kann Uber das Stiftsymbol direkt bearbeitet
werden.

Aktionen: Uber den Link ,Bearbeiten” kénnen Sie die jeweilige Frage bearbeiten, duplizieren, I6schen,
den Verlauf oder eine Vorschau abrufen uvm.

Status: Diese Spalte bezeichnet, ob die Frage sich im Entwurfs-Status befindet oder ob sie bereit fur die
Verwendung ist.

Version: Hier sehen Sie, auf welche Version der Frage sich die jeweilige Zeile bezieht — Details kdnnen
Sie Uber den Punkt , Verlauf” im Aktionsmen( abrufen.

,Erstellt von” bzw. ,Gedndert von”: bezeichnen, wann eine Frage erstellt oder zuletzt geandert wurde
und von welchem User diese Aktion durchgefiihrt wurde.

Kommentare: Andere Trainer:innen kénnen im Zuge des Peer Reviews oder der Qualitatssicherung in
dieser Spalte Riickmeldungen oder Hinweise zu einer Frage eintragen. Dies kann per Klick auf die Anzahl
der Kommentare direkt von der Fragensammlung aus erfolgen.

Uberpriifung nétig?: Basierend auf Fragenstatistiken wird eine Frage in dieser Spalte gekennzeichnet,
falls sie regelmaRig zu ,AusreiBern” nach oben oder unten fiihrt. Damit sollen die jeweiligen
Trainer:innen auf eine weitere Uberpriifung der Frage aufmerksam gemacht werden, um
sicherzugehen, dass nicht z. B. eine falsche Antwort als richtig definiert wurde.

Leichtigkeitsindex: In dieser Spalte wird die durchschnittlich bei dieser Frage erzielte Punktzahl (in
Prozent) angegeben. Je hoher diese ist, umso leichter ist die Frage normalerweise.
Trennscharfe-Effizienz: Der Wert in dieser Spalte ist eine statistische Schatzung, die anzeigt, wie gut die
Frage die Teilnehmer:innen bewertet, also ob tendenziell Teilnehmer:innen, die beim gesamten Test
gut abschneiden, auch diese Frage richtig beantworten. Je héher der Wert, desto besser.
Verwendung/Zuletzt verwendet: Diese Spalte zeigt an, wie oft und wann die Frage zuletzt eingesetzt
wurde.

Ndhere Informationen zur Fragensammlung finden Sie hier.
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Kurse und Inhalte wiederverwenden

Sie kdnnen die Kurse lhrer Instanz sichern, um sie auch in anderen Moodle-Installationen zu nutzen, oder Kurse
von anderen Instanzen in lhre Instanz importieren und diese ggf. anpassen und im Anschluss in Ihrem Unterricht
einsetzen.

Administration

 Kurs-Administration
 Einstellungen
¥ Nuter/innen

Hinweis: Grundsatzlich beziehen sich die Ausfiihrungen in diesem Kapitel auf das Design 2 Sebst s iesem Kurs abmelden
,Boost”.

Falls Sie mit dem Design ,,Classic” arbeiten, kdnnen Sie die vorgestellten Funktionalitdten
Uber den Block ,,Administration” aufrufen — ab Schritt 2 kdnnen Sie sich an der folgenden
Kurzanleitung orientieren.

¥ Kl-Fragen

> Website-Administration

Sicherung eines Kurses

Die Sicherung eines Kurses wird direkt aus dem jeweiligen Kurs vorgenommen:

1. Klicken Sie in der Navigationsleiste auf ,Mehr” und anschlieBend auf ,Kurse wiederverwenden”.

Demo-Kurs

Fragensamming
. Badges
Kompetenzen

Filter

Dateiverwaltungen

2. Klicken Sie den Punkt ,Sicherung” an:

Demo-Kurs

Kurs  Einstelungen  Teilnehmerfinnen  Bewertungen  Berichte Mehr

Kurs wiederverwenden

Zuracksetzen

3. AnschlieBend kdnnen Sie festlegen, welche Daten aus dem Kurs gesichert werden sollen bzw. ob auch die
Daten der Benutzer:innen mitgesichert werden sollen (Schritt 1 der Sicherung). Im nachsten Schritt wird
abgefragt, ob der gesamte Kurs oder nur einzelne Teile in die Sicherung miteinbezogen werden sollen. Sie
konnen lhre Auswahl ganz einfach durch Anhaken der entsprechenden Punkte treffen (Schritt 2) und
kénnen — wenn gewinscht — in Schritt 3 auch den Namen der Sicherungsdatei anpassen. Die Dateiendung
muss allerdings .mbz bleiben.
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4. Nach einer Kontrolle der Auswahl wird die Sicherung durchgefiihrt, und Sie kénnen im Anschluss die
Kurssicherung herunterladen und bei sich am Computer abspeichern.

Demo-Kurs

Wiederherstellen -

Verweniden Se ine Sicherungatate, um cin:frahere Uerscan eines Kirses seseersstelen e eine neen Kiss 7 erseten.
Sicherungsdatei hochladen

cresun @ Cateivation .

Sicherungsdateien des Kurses

Nahere Informationen finden Sie auch hier.

Hinweis: Bitte beachten Sie, dass bei der Sicherung eines Kurses durch eine:n Trainer:in die Benutzer:innendaten
Ublicherweise nicht mitgesichert werden kénnen.
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Sicherung einer einzelnen Aktivitat

Neben kompletten Kursen kénnen auch einzelne Aktivitdten gesichert und an anderer Stelle wiederhergestellt

werden. Offnen Sie dazu die jeweilige Aktivitit und klicken Sie in der Navigationsleiste oben auf ,Mehr >
Sicherung”:

Do worment ot g b omnd

Datenbank Einstellungen Vorlagensatze Felder Vorlagen Mehr v

Filter
Rechte
Logdaten

Wiederherstellen g ———

Die weiteren Schritte sind identisch zur Erstellung von Kurssicherungen.
Nahere Informationen zum Sichern einzelner Aktivitaten finden Sie auch hier.

Hinweis: Falls Sie mit dem Design ,,Classic” arbeiten, findet sich die Funktionalitdt zum Sichern von Aktivitaten
im Block ,,Administration” in der Aktivitats-Administration:

Administration

v Forum-Administration

0 Einstellungen
2 Lokale Rollen
Zuweisen

Za Rechte

2a Rechte priifen
W Filter

1 Logdaten

@ Wiederherstellen
@ Erweiterte Bewertung
> Abonnement

B Abonnements
W Berichte

B Export

» Kurs-Administration

> Website-Administration

Wiederherstellung eines Kurses bzw. einer Aktivitat

Die Wiederherstellung eines Kurses oder einer Aktivitdt kann aus jedem beliebigen Kurs oder (sofern Sie
Administrationsrechte besitzen) direkt von , Website-Administration > Kurse > Kurs wiederherstellen” aus
vorgenommen werden.

1. Klicken Sie in der Navigationsleiste eines Kurses auf ,,Mehr” und anschlieRend auf , Kurs wiederverwenden®.

Demo-Kurs
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2. Klicken Sie den Punkt ,,Wiederherstellen” an:

Demo-Kurs

Kurs Einstellungen Teilnehmer/innen Bewertungen Berichte Mehr +

Kurs wiederverwenden

Import
Sicherung

Wiederherstellen

Kurs duplizieren
Zuriicksetzen

3. Sie kénnen nun entweder eine Sicherung von lhrem Computer hochladen, indem Sie auf ,,Datei wahlen...”
klicken (Ziffer 1) oder eine Sicherung aus einem Sicherungsbereich (Ziffer 2) fur die Wiederherstellung
nutzen.

Klicken Sie auf den Button bzw. den Link ,Wiederherstellen“:

Demo-Kurs

Wiederherstellen
e St e Schen e, U ine TiAere Versor enes K avedsbeausteben ode e e K 2 eriele,
Sicherungsdatei hochladen

Sicherungsdateien des Kurses @
[ R T —

4. AnschlieBend erhalten Sie einen Uberblick iber die Daten des Kurses/der Aktivitat, die Sie mit Klick auf
»Weiter” bestdtigen kénnen.
Im nachsten Schritt wird abgefragt, wo die Sicherung wiederhergestellt werden soll: Sofern es sich um einen
kompletten Kurs handelt, konnen Sie auswéhlen, ob ein neuer Kurs erstellt werden soll (und wenn ja, in
welchem Kursbereich) oder ob der Kurs in einem bestehenden Kurs wiederhergestellt werden soll. Bei der
Wiederherstellung einer Aktivitat kdnnen Sie nur den Zielkurs auswahlen.
Wahlen Sie die gewiinschte Option aus, und klicken Sie wieder auf ,,Weiter”.

5. Nun koénnen Sie festlegen, welche Daten aus dem Kurs wiederhergestellt werden sollen (z. B. Daten der
Benutzer:innen (sofern die entsprechenden Berechtigungen vorliegen), gesamter Kurs vs. einzelne Kursteile
etc.). Sie konnen Ihre Auswahl ganz einfach durch Anhaken der entsprechenden Punkte treffen.

Zusatzlich kénnen Sie den Namen bzw. Kurznamen des Kurses anpassen sowie das Datum des Kursbeginns
festlegen.

6. Nach einer Kontrolle der Auswahl wird die Wiederherstellung durchgefiihrt, und Sie gelangen am Ende des
Prozesses durch Klick auf ,Weiter” direkt in den Zielkurs:

Demo-Kurs

tellungen  Tellnehmerfinnen  Bewertungen  Berichte  Mehr v

1. Bestatigen = 2 Ziel = 3, Einstellungen = 4. Schema ~ 5. (berprofen ~ 6, Ausfufiren ~ 7. Fertig

Des Kurs wurde erfolgreich wiederhergestelit x
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Nahere Informationen zur Kurswiederherstellung finden Sie auch hier; die Wiederherstellung von Aktivitdten ist
hier naher beschrieben.

Hinweis: Bitte beachten Sie, dass in Ihrer Instanz standardmaRig nur der Upload von Dateien bis zu 128 MB
moglich ist. Falls Sie groRere Dateien (z. B. eben Kurssicherungen) hochladen mochten, wenden Sie sich bitte an
unseren Support — wir helfen Ihnen hier gerne weiter!

Kurs zurlicksetzen

Unter dem ,,Zuriicksetzen” eines Kurses versteht man das Loschen aller Daten der Benutzer:innen eines Kurses
— die Kursinhalte (Aktivitaten, Materialien, Blocke ...) bleiben vorhanden. Dies eignet sich beispielsweise, wenn
ein Kurs in einem darauffolgenden Semester wieder zum Einsatz kommen soll.

Hinweis: Bitte beachten Sie, dass das Zuriicksetzen eines Kurses nicht riickgangig gemacht werden kann! Wir
empfehlen, eine Kurssicherung mit den Daten lhrer Benutzer:innen aufzubehalten!

1. Klicken Sie in der Navigationsleiste auf ,Mehr” und anschlieRend auf ,Kurs wiederverwenden”.

Demo-Kurs
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2. Klicken Sie den Punkt ,Zuriicksetzen” an:

Demo-Kurs

Kurs  Einstellungen  Teilnehmer/innen

Kurs wiederverwenden

mport
Sicherung
ferherstellen

L B
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Bewertungen  Berichte  Mehr ~

3. Sie kénnen im néchsten Schritt sehr granular festlegen, welche Daten des Kurses geldscht bzw. angepasst

werden sollen. Sie kdénnen z. B. User aus einem Kurs abmelden, die Kursdaten andern, Aktivitaten

zuriicksetzen usw. — bestatigen Sie anschlieend mit ,,Kurs zurlicksetzen:

Zuriicksetzen .

Allgemein
Rollen
Bewertungen
Gruppen

Foren

Tests.

Spiele
BigBlueButton
H5P

Kurszertifikate

>
>
>
>
>
» Glossare
>
>
>
>
>
>

Zuriicksetzen ist nicht vorgesehen

Standard ausudiien  Nichts suswdhlen

4. AnschlieRend erhalten Sie eine Ubersicht der im Rahmen der Kurszuriicksetzung vorgenommenen

Anderungen und kénnen mit Klick auf ,Weiter” in den entsprechend angepassten Kurs zuriickkehren:

Demo-Kurs

Kurs

Zuriicksetzen -

Element Zuriicksetzen
Kurszertifikate Certificates archived

Unterabschnitte

Néahere Informationen finden Sie auch hier.

Kurs importieren

Die Funktion ,Importieren” kann genutzt werden, um Inhalte von einem Kurs in einen anderen Kurs zu

importieren (entsprechende Rechte in beiden Kursen vorausgesetzt). So koénnen Inhalte unkompliziert

wiederverwendet werden. Die Importfunktion dhnelt dem ,,Sichern“ und , Wiederherstellung” (von Teilen) eines

Kurses ohne Benutzer:innendaten.

Falls Sie eine Aktivitat oder einen Kurs innerhalb derselben Instanz an anderer Stelle nutzen mochten, ist

empfehlenswert, diese nicht zu sichern und anschliefend wiederherzustellen, sondern die ,,Import“-Funktion

Zu nutzen.
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Die Importfunktion muss immer von dem Kurs aus gestartet werden, in den Inhalte importiert werden sollen:

1. Klicken Sie in der Navigationsleiste auf ,Mehr” und anschlieRend auf ,Kurs wiederverwenden®”.

Demo-Kurs

Doepl Ubersetzer

2. Klicken Sie den Punkt ,,Import” an:

Demo-Kurs

Kurs  Einstellungen  Teilnehmerfinnen  Bewertungen  Berichte  Mehr~

Kurs wiederverwenden

Sicherung
Wiederherstellen
Kurs duplizieren
Zuricksetzen

3. Wahlen Sie im Anschluss den Kurs aus, aus dem Sie Inhalte importieren mochten (Schritt 1: Kursauswabhl)
und im Anschluss die Kursinhalte, die importiert werden sollen.

4. Bestéatigen Sie mit ,,Import durchfiihren” —im Anschluss kénnen Sie per Klick auf ,Weiter” direkt in den Kurs
zurlickkehren:

Demo-Kurs

Import -
mportieren Sie Blemente aus anderen Kursen, 28, AKtivitaten, Blocke oder Kalenderereignisse. £S werden keine Nutzerdsten

@bemommen

wahl = 2. Grundeinstellung ~ 3. Schema-Einstelungen ~ 4. Bestatigung und Profung = 5. Import durchfufiren ~ 6. Fertig

Der Import ist abgeschiossen. Kiicken Sie auf "Weiter”, um in den Kurs zu gelangen x

N&here Informationen finden Sie auch hier.

Flir Administrator:innen:

Sonstige Hinweise und empfehlenswerte Einstellungen

Papierkorb

Mit Hilfe des Papierkorbs kdénnen versehentlich geléschte Inhalte bzw. ganze Kurse fiir eine gewisse Zeit
wiederhergestellt werden.
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Der Papierkorb ist auf allen Instanzen standardmaRig aktiviert; der:die Administrator:in kann unter , Website-
Administration > Plugins > Dienstprogramme > Papierkorb” festlegen, wie lang Inhalte im Papierkorb erhalten
bleiben sollen bzw. ob der Link zum Papierkorb auch angezeigt werden soll, wenn der Papierkorb leer ist.

Wiederherstellen von geldschten Kursinhalten

Wenn Sie Inhalte aus einem Kurs wiederherstellen mochten, die geléscht wurden, funktioniert dies

folgendermalRen:

1. Klicken Sie in der Navigationsleiste des jeweiligen Kurses auf ,Mehr” und anschlieend auf ,,Papierkorb”:
Demo-Kurs

Kurs  Einstellungen  Teilnehmer/innen  Bewertungen  Berichte  Mehr ~

Fragensammiung
Inhaltsspeicher

' . . Kursabschluss
Badges
Kompetenzen
Filter
Dateiverwaltungen

LTI Externe Tools

a £y Tools zur Barrierefreiheit
v v Zetifikate

| Deepl Ubersetzer

Kurs wiederverwenden

Ki-Fragen

2. Inder darauffolgenden Ubersicht sehen Sie, welche Inhalte sich aktuell im Papierkorb des jeweiligen Kurses
befinden und konnen diese wiederherstellen oder endgiiltig 16schen:

Demo-Kurs: Papierkorb

Die Inhalte bleiben fur 7 Tage erhalten bevor sie endgiltig geldscht werden.

Aktivitit Datum geldscht Wiederherstellen Loschen
[ Aufgabe hier hochladen Freitag, 25. Juli 2025, 07:41 7] o
Alle I6schen

Zurick zu Kurs: Demo-Kurs

Wiederherstellen von geldschten Kursen

Administrator:innen koénnen darliber hinaus auch versehentlich geléschte Kurse aus dem Papierkorb

wiederherstellen.

1. Gehen Sie dazu auf ,Website-Administration > Kurse > Kurse und Kursbereiche verwalten”, und klicken
beim Kursbereich, in dem sich der geléschte Kurs befunden hat, auf das Dreipunkt-Meni. AnschlieBend den

,Papierkorb” auswahlen:
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Kursbereiche und Kurse bearbeiten

Kursbereiche
Neuen Kursbereich anlegen

C Verschiedenes ® b i 153

( Grunc & Anzeigen e
# Bearbeiten

[\ Demc & MNeuen Kursunterbereich anlegen =
@ Loschen

( + Kurss: 1@
&a Rechte

Wird neu geordr = Globale Gruppen

Ausgewahlte Ku Y Filter

Kurs wiederherstellen

B Papierkorb

L& Inhaltsspeicher

2. Nun sehen Sie, welche Kurse sich aktuell im Papierkorb des Kursbereichs befinden und kdénnen diese
wiederherstellen oder endgltig 16schen:

Kursbereich: Verschiedenes: Papierkorb

Die Inhalte bleiben fur 7 Tage erhalten bevor sie endgltig geléscht werden.

Kurs Datum gel&scht Wiederherstellen Loschen
Abschluss Freitag, 25. Juli 2025, 09:32 [+] o
Alle Idschen

Zuriick zu Kursbereich: Verschiedenes

Nahere Informationen finden Sie auch hier.

Hinweis: Nach dem Léschen von Inhalten auf Ihrer Instanz dauert es normalerweise einige Minuten, bis diese im

jeweiligen Papierkorb auftauchen.

Filter aktivieren

Filter durchsuchen bei der Eingabe von Inhalten bzw. dem Upload von Dateien alle Inhalte und fiihren dann
bestimmte Aktionen aus. Aktivieren kdnnen Sie sie liber , Website-Administration > Plugins > Filter > Ubersicht”.

Da jeder Filter die Serverleistung beeintrachtigt, sollten Sie nur mit den wichtigsten arbeiten. Vor allem zu
erwdhnen ist hier der Filter Multimedia-Plugins: Er ersetzt Verlinkungen im Text, die auf Multimedia-Inhalte
verweisen, mit einem geeigneten Player. So wird beispielsweise ein Link auf ein YouTube-Video in einem Textfeld
direkt so umgewandelt, dass es direkt im Kurs angezeigt und abgespielt werden kann.

Néahere Informationen finden Sie auch hier.
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Texteditoren konfigurieren

Die Administrator:innen konnen umfangreiche Grundeinstellungen fiir die Texteditoren lhrer Instanz
vornehmen. Ndhere Informationen zu Texteditoren im Allgemeinen finden Sie im Kapitel ,Arten von Inhalten in
einem Kurs”“.

Zunichst kdnnen Sie unter ,Website-Administration > Plugins > Texteditoren > Ubersicht” festlegen, welche
Texteditoren auf der Instanz Gberhaupt verfiigbar sein sollen:

Ubersicht
Name Version Aktiviert il olge Ei llungen Deinstallieren
Editor TinyMCE 2024100701 () + Einstellungen Deinstallieren
Editor Atto 2024100700 [ @) ™ 4 Einstellungen Deinstallieren
Einfacher Text 2024100700 O +

Der Texteditor, der in dieser Aufstellung als erster genannt ist, wird von den Nutzer:innen standardmaRig
verwendet. Sofern mehr als ein Texteditor auf der Instanz aktiviert ist, kdnnen die Nutzer:innen allerdings Gber
ihr jeweiliges Profil Gber , Einstellungen > Texteditor” auswéahlen, welchen Editor sie selbst fiir die Bearbeitung
von Texten verwenden mdchten:

S NOE

Hannes Lehrer
Profil

Bewertungen Einstellungen
Kalender
Mitteilungen Nutzerkonto ~

Profil bearbeiten
Kennwort andern

Meine Dateien

Berichte Sprache wahlen
Einstellungen Kalender einstellen
1 Inhaltsspeicher einstellen
Sprache » P
Sicherheitsschlisse
Mitteilungen
Logout Systemnachrichten

- = -—

Daneben kdénnen sie den Funktionsumfang des jeweiligen Texteditoren anpassen und erweitern: Dabei lassen
sich gezielt Schaltflaichen aktivieren oder deaktivieren, ihre Reihenfolge anpassen oder festlegen, welche
Zusatzfunktionen Uber das bloRe Formatieren von Text hinaus verfiigbar sein sollen.

Bei TinyMCE gelangen Sie Uber ,Website-Administration > Plugins > Texteditoren > Editor TinyMCE >
Einstellungen” auf die Ubersicht der Funktionalititen und kénnen diese per Schieberegler aktivieren bzw.
deaktivieren:

Einstellungen
Name Version Aktiviert Einstellungen Deinstallieren
Autosave 2024100700 [ @) Deinstallieren
Gleichungseditor 2024100700 O Einstellungen Deinstallieren
H5P einfigen 2024100700 () Deinstallieren
LITMI 30124100700 [ & Nainctallisran

In einigen Fallen — wie im obigen Screenshot beim Gleichungseditor — konnen Sie daneben noch zusétzliche
Einstellungen treffen. Ndhere Informationen sind hier zu finden.
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Im Gegensatz dazu konnen Sie beim Atto-Editor nicht nur festlegen, welche Funktionalitditen zum Einsatz
kommen, sondern auch, in welcher Reihenfolge diese angezeigt werden. Hier finden Sie die Ubersicht der
Einstellungen Uber ,Website-Administration > Plugins > Texteditoren > Editor Atto > Einstellungen®.

Im oberen Bereich der Seite sehen Sie die auf Ihrer Instanz zur Verfligung stehenden Funktionalitaten.

Einstellungen

Atto Plugins

Name
Tests zur Barrierefreiheit
Hilfe far Screenreader
Textausrichtung
Hintergrundfarbe

Fatt

Version

2024100700

2024100700

2024100700

2024100700

2024100700

accessibilitychecker

accessibilityhelper

align

backcolor

hold

Deinstallieren

Deinstallieren

Deinstallieren

Deinstallieren

Deinstalliersn

Wenn Sie nach unten scrollen, kénnen Sie im Bereich ,,Menileiste” festlegen, welche Funktions-Buttons in der
Werkzeugleiste des Editors zu sehen sein sollen.

Die Buttons in der Leiste sind in Gruppen angeordnet, um die Mendiileiste fiir den User Gbersichtlich und logisch
zu gestalten. Die Gruppen kénnen von Ihnen beliebig benannt werden. Die Gruppennamen dirfen allerdings nur
einmal vorkommen und lediglich Zahlen oder Buchstaben enthalten:

Mendleiste
editor_atto | toolbar

links = link, teamsmeeting

files = wordimport, image, media, managefiles, recordrtc, hSp

align = align
indent = indent

insert = equation, charmap, table, clear

undo = undo

accessibility = accessibilitychecker, accessibilityhelper

other = html

5 A

Das Hinzufligen eines Buttons in lhrer Werkzeugleiste funktioniert, indem Sie die Bezeichnung des gew{inschten

Buttons aus der Spalte ,,Menlileiste” der Tabelle oben auf der Seite ibernehmen:

Einstellungen

Atto Plugins

Name
Tests zur Barrierefreiheit
Hilfe far Screenreader
Textausrichtung
Hintergrundfarbe

Eatt

Version

2024100700

2024100700

2024100700

2024100700

2024100700

D

accessibilitychecker
accessibilityhelper
align

hald

Deinstallieren

Deinstallieren

Deinstallieren

Deinstallieren

Deinstallieren

Geben Sie anschlieBend den Namen des Buttons bei der gewiinschten Gruppe der Mendleiste ein — wenn
gewlinscht, kdnnen Sie naturlich auch eine neue Gruppe erstellen:
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MRS = TR, (EdTTISITTEE Ty

files = wordimport, image, media, managefiles, recordrtc, hSp

align = align

indent = indent

insert = equation, charmap, table, clear

undo = undo

accessibility = accessibilitychecker, accessibilityhelper
other = html

| demo = backcolorl

5 | 4

Im Editor selbst sieht das Ganze dann folgendermalien aus:

v  Av B | I #v E E @& RN W

W W @ LE ¢ m g

= =2 =2 E E xEF B o o I
> || v

Nahere Informationen rund um die systemweit giiltigen Einstellungen des Atto-Texteditors finden Sie hier.

Upload grolder Dateien

Sie konnen keine groRen Dateien direkt auf unseren Server speichern — beim Upload lber das Frontend Ihrer
Lernplattform gilt (abhadngig von den Einstellungen, die durch den:die jeweilige:n Adminstrator:in getroffen
wurden) eine GroRRenbeschrankung von max. 128 MB.

Wir stellen Ihnen hierfiir gerne einen Zugang zu unserem Tool ,Filebrowser” zur Verfligung, mit dem Sie beliebig
groRe Dateien, mehrere Dateien, Kurssicherungen oder ganze Verzeichnisse in Ihre Instanz laden kénnen.

Bitte wenden Sie sich, falls hier Bedarf bestehen sollte, einfach an unseren Support!

Eingerlickte Darstellung von Kursinhalten erlauben

In den Kursformaten ,Themenformat” und ,,Wochenformat” besteht die Moglichkeit, Kursinhalte eingeriickt
darzustellen (vergleichbar mit einem Texteinzug in z. B. Word). Allerdings ist hier lediglich eine einmalige
Einrtickung moglich.

~  Allgemeines

Alles einklappen

(=) Ankondigungen

334 Ubung

R Aufgabe

Gedffnet: Fraitag, 9. Mai 2025, 00:00 Fillig: Freitag, 16. Mai 2025, 00:00

Dies muss von der jeweiligen Administratorin bzw. dem jeweiligen Administrator einmalig Gber ,Website-
Administration > Plugins > Kursformate > Kursformate verwalten” und den Punkt ,Einstellungen” bei den
jeweiligen Kursformaten (Themenformat bzw. Wochenformat) einmalig per Hakerl aktiviert werden.
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Kursformate verwalten

Kursformate
Name Aktivieren i i Dei
Themenabschnitte @ +
Wochenabschnitte Standard L
Einzelaktivitat @ L Deinstallieren  Einstellungen
Sozial @ L Deinstallieren
Grid Format @ L Deinstallieren
Ein-Themen-Format @ L Deinstallieren  Einstellungen
scorm = L Deinstallieren
Kachelformat @ L Deinstallieren  Einstellungen
Komprimierte Abschnitte @ + Deinstallieren

Standardformat kann gedndert werden in ‘Grundeinstellungen

Themenabschnitte

Einriicken auf Kursseite zulassen St

Trainer/innen und anderen Personen mit dem Recht zum Verwalten von Aktivitaten erlauben, Elemente auf
der Kursseite einzuricken.
Einzug seitenweit zuriicksetzen

Anderungen speichern

Im Anschluss steht die entsprechende Option im Dreipunkte-Menti des jeweiligen Kursinhalts zur Verfiigung:

Aufgabe # H
Gedffnet: Freitag, 9. Mai 2025, 00:00  Féllig: Freitag, 16. Mai 2025, 00:00

¢ CEinstellungen bearbeiten
Infos zu den Wortarten #° b Verschieben
I-) Nach rechts schieben
@ Verfligbarkeit >
Ubung # @ Duplizieren
23 FRollen zuweisen
Ubung Il # ® Gruppenmodus >
@ Loschen

Verwendung von Unterabschnitten

Kurse kénnen ab der Moodle-Version 4.5 nicht nur in Kursabschnitte gegliedert werden — daneben gibt es auch
noch die Moglichkeit, mit Unterabschnitten zu arbeiten. Diese haben u. a. den Vorteil, dass zusammengehoérende
Inhalte visuell besser gruppiert werden kénnen und damit Kurse Ubersichtlicher gestaltet werden kénnen.

Diese Option muss von dem:der Administrator:in einmalig aktiviert werden. Gehen Sie dazu auf ,Website-
Administration > Plugins > Aktivitdten > Ubersicht” und betatigen Sie den Schieberegler bei ,,Unterabschnitt”.

[/ UMVETsEnes Texieia (V) ZUZIUZU40Z L W) EIMSTENUMYETT DETSTENTETET
® Unterabschnitt 2 2024100700 " @) Deinstallieren
@ Linterkurs 1 2025032000 a Finstellunaoen Deinstallieren

Informationen zum Anlegen eines Unterabschnitts finden Sie im Kapitel , Kursinhalte anlegen®.

Verwendung von BigBlueButton
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BigBlueButton dient dazu, um direkt in Ihrer Instanz Videokonferenzen erstellen und durchfiihren zu kénnen. Es
handelt sich hierbei um ein Open Source-Webkonferenzsystem, das Uber eine Schnittstelle mit Ihrer Instanz
verbunden ist, und mit einigen Einschrankungen kostenlos genutzt werden kann.

Damit Trainer:innen eine BigBlueButton-Aktivitdt in einem Kurs anlegen konnen, ist es notwendig, dass
BigBlueButton durch den:die Administrator:in einmalig aktiviert wird, da dieses Plugin aus Datenschutzgriinden
standardmaRig deaktiviert ist.

Das Aktivieren des Plugins funktioniert iiber ,Website-Administration > Plugins > Aktivititen > Ubersicht”.

= ocirayurny v [AVEASy Fa v vy ‘_} (ML= LRI RY =]} LIS anreTeTd
©® BigBlueButton 0 2024100700 @) Einstellungen Deinstallieren
m_Purh n 2024100700 ) Einstallinaen

Betatigen Sie erst den Schieberegler neben ,BigBlueButton” und klicken Sie anschliefend auf ,Einstellungen”.
Im oberen Bereich der Seite finden Sie einen Link zur Registrierung beim Provider von BigBlueButton (Blind Side
Networks Inc.) —fillen Sie die Registrierung aus, um die fiir die Nutzung notwendigen Informationen zu erhalten.
Falls Sie flr die Nutzung von BigBlueButton einen eigenen Server verwenden, kdnnen Sie auf dieser Seite die
entsprechenden Daten direkt eintragen.

Weitere Informationen finden Sie auch hier.

Plugins deaktivieren

Auf Ihrer Instanz steht eine groRe Anzahl von Aktivitdten, Arbeitsmaterialien und Blocken zur Verfiigung — einige
von lhnen erflllen sehr spezielle Zwecke, andere kommen unserer Erfahrung nach sehr haufig zum Einsatz. Einige
wichtige Inhaltstypen sind in diesem Handbuch exemplarisch aufgefiihrt.

Gerade aufgrund dieser umfangreichen Auswahlmoglichkeiten wirkt die Lernplattform gerade auf wenig
erfahrene Benutzer:innen u. U. iberfordernd. Sie als Administrator:in kénnen dem aber entgegenwirken, indem
Sie Aktivitaten, Arbeitsmaterialien oder Blocke, die auf Ihrer Instanz aller Voraussicht nach nicht bendtigt
werden, deaktivieren, sodass sie beim Anlegen von Kursinhalten nicht angezeigt werden und damit auch nicht
ausgewahlt werden kénnen.

Die folgende Beschreibung erklart das Deaktivieren am Beispiel einer Aktivitat bzw. eines Arbeitsmaterials.

Gehen Sie dazu auf ,Website-Administration > Plugins“ und auf den Link ,,Ubersicht” neben , Aktivititen“:

Website-Administration Suchen B
Allgemein  Nutzerfinnen  Kurse  Bewertungen  Plugins  Darstelung  Server  Berichte  Mehrv
Plugins Plugin-Ubersicht

Aktivititen

Anschliefend sehen Sie eine Auflistung aller auf lhrer Instanz verfligbaren Typen von Aktivitaiten und
Arbeitsmaterialien (diese sind in dieser Liste zusammengefasst).

Klicken Sie auf den Regler (rot markiert), um diesen zu deaktivieren, damit der jeweilige Kursinhalt nicht mehr
angelegt werden kann. Die blau markierte Zahl zeigt an, wie oft das jeweilige Element auf lhrer Instanz verwendet
wurde. Wenn Sie daraufklicken, gelangen Sie zu einer Ubersicht der entsprechenden Kurse:

v
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Aktivitidten
Name Aktivitdten Version Aktiviert il Dei
% Abstimmung 2024100700 @ Deinstallieren
& Anwesenheit 3 2024072400 [ @) Einstellungen
a_Aufaabe 70 2024100700 a Einstellungen

Ndhere Hinweise zum Deaktivieren einer Aktivitdt finden Sie hier; das Deaktivieren von Blocken funktioniert
analog und ist hier ndher beschrieben.

Bitte beachten Sie Folgendes:

e Durch das Deaktivieren ist der jeweilige Inhaltstyp auf Ihrer gesamten Instanz nicht mehr sichtbar: Das
bedeutet nicht nur, dass keine dementsprechenden Inhalte mehr neu angelegt werden kann, sondern
auch, dass bestehende Inhalte in den Kursen ausgeblendet werden.

Deaktivieren Sie daher nur Blocke bzw. Aktivitaten, die noch in keinen Kursen vorhanden sind bzw. von
denen Sie wissen, dass Sie nicht (mehr) benétigt werden.

e  Einige Aktivitdten bzw. Blocke sind auf Ihrer Instanz standardmaRig deaktiviert. Wir empfehlen, diese —
mit Ausnahme der Aktivitat BigBlueButton — deaktiviert zu lassen.

e Uberden Link ,Deinstallieren“ kdnnen Sie Plugins aus lhrer Instanz nicht komplett deinstallieren. Dieser
hat fiir Sie aufgrund des speziellen Aufbaus unserer Lernplattform 00-Umgebung keine Funktion — die
Installation bzw. Deinstallation von Plugins ist ausschlieBlich durch das Team der Education Group
moglich.

Datenschutzanfragen

Wenn gewinscht, konnen Sie Ihren Usern u. a. die Mdglichkeit geben, direkt tber ihr Profil die Daten zu
exportieren, die Uber sie in der Instanz gespeichert sind, oder ihren eigenen Account komplett zu I6schen.

® Hannes Lehrer ® wising

Mehr Details Verschiedenes
ofil bearbeiten

E-Mail-Adresse

tesLiehrer@byom.de (sichtbar fr Teilnehmer/innen

im Kurs)

Land

Ostemeich

Stadt

Linz

Zeitzone

Europe/Berlin

Datenschutz und Richtiinien Login-Aktivitat

Letater Zugriff auf die Website
Freitag, 25, Juli 2025, 1057 (jetzt)

Mobile App

QR-Code fiir den Zugriff mit der mabilen App

Scannen Sie den OR-Cade mit Inver mabilen App
Kursdetalls und Sie werden automatisch angemeldet, Der OR-
Kursprofile Code fauftin 10 Minuten ab,

Damit diese Optionen auf der Profilseite der jeweiligen User sichtbar sind, ist es erforderlich, unter , Website-
Administration > Nutzer/innen > Datenschutz und Richtlinien > Datenschutzeinstellungen” beim Punkt ,Kontakt
fir Datenschutzanfragen” ein Hakerl zu setzen. Ublicherweise fungiert der:die Administrator:in als dieser
Kontakt, es ist aber auch moglich, ,,Datenschutzbeauftragte:r” als eigene Rolle zu definieren. Lost ein:e Nutzer:in
hier eine Aktion aus, sieht die jeweilige Kontaktperson rechts oben in der Instanz, dass eine neue
Benachrichtigung vorliegt, und kann von dort aus die jeweilige Anfrage ansehen und bearbeiten:
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A B TS

Systemnachrichten v 2

d‘? Datenanfrage: Alle Gber mich gespeicherten Daten exportieren

2 Stunden 37 Minuten ak Mitteilung vollstindig anzeigen

Unter ,Website-Administration > Nutzer/innen > Datenschutz und Richtlinien” kdnnen durch den:die
Administrator:in diverse Grundeinstellungen rund um den Datenschutz festgelegt werden (z. B.
Datenschutzrichtlinien, Aufbewahrungsfristen ...). Nahere Informationen zu diesem Thema finden Sie auch hier.

‘,.Qh‘f‘l Education
N Group Moodle 4.5 | Stand 2025 78

Die Bildungsagentur


https://docs.moodle.org/405/de/Datenschutz_in_Moodle

	Grundlegendes zu Beginn
	Struktur einer Lernplattform OÖ-Instanz
	Rollen auf Ihrer Instanz
	Der Administrator/Die Administratorin
	Weitere Rollen


	Für Administrator:innen: Konfigurieren der Instanz
	Erste Schritte
	Verwendung des Designs „Boost“
	Verwendung des Designs „Classic“

	Gestaltung der Instanz
	Einstellungen der Startseite
	Dashboard für alle User anpassen
	„Meine Kurse“
	Blöcke in verschiedenen Kontexten
	Design-Auswahl und -Einstellungen
	Logo

	Website registrieren

	Für Administrator:innen: User und Registrierung
	Neue Benutzer:innen händisch anlegen
	Nutzer:innen über eine Liste hochladen
	Selbstregistrierung der User erlauben
	Authentifizierung über OAuth2
	Weitere Authentifizierungsmethoden
	Multi-Faktor-Authentifizierung
	Nutzerprofile
	Ändern eines Userprofils oder Kennworts
	Globale Gruppen
	Mitteilungen & Systemnachrichten
	Einschreibemethoden verwalten
	Gastzugang erlauben
	Gastzugang beim Login aktivieren
	Gastzugang als Einschreibemethode definieren

	Zugriff auf Startseite und Kursübersicht beschränken

	Für Administrator:innen:  Kursbereiche und Kurse anlegen und konfigurieren
	Anlegen eines Kursbereichs
	Anlegen eines Kurses
	Anlegen von Kursen durch Trainer:innen

	Einschreiben von Trainer:innen in einen Kurs

	Für Trainer:innen: Konfigurieren eines Kurses
	Erste Schritte - Aufrufen der Einstellungen
	Verwendung des Designs „Boost“
	Verwendung des Designs „Classic“

	Grundeinstellungen des Kurses
	Kursformate
	Abschlussverfolgung
	Voraussetzungen


	Für Trainer:innen:  Inhalte in einen Kurs hinzufügen
	Aktivieren des „Bearbeiten“-Modus
	Verwendung des Designs „Boost“
	Verwendung des Designs „Classic“

	Wichtige Symbole
	Kursabschnitte anlegen
	Kursinhalte anlegen
	Bearbeiten von Kursinhalten
	Dateien und externe Repositories

	Arten von Inhalten in einem Kurs
	Arbeitsmaterialien
	Texteditoren

	Aktivitäten
	Aufgabe
	BigBlueButton
	Feedback
	Forum
	Glossar
	Interaktiver Inhalt (H5P)
	Kurszertifikat
	Test

	Blöcke
	Fortschrittsbalken
	Level Up XP


	Für Trainer:innen:  Rund um die Kursteilnehmer:innen
	Einschreibemethoden im Kurs verwalten
	Manuelle Einschreibung
	Selbsteinschreibung in Kurse erlauben
	Gastzugriff erlauben
	Einschreibung über Globale Gruppen
	Globale Gruppen – Gruppen – Gruppierungen
	Globale Gruppen
	Gruppen
	Gruppierungen


	Bewertungen
	Ermittlung der Gesamtbewertung eines Kurses
	Bewertungsskalen anlegen

	Fragensammlung
	Anlegen von Kategorien
	Anlegen von Fragen
	Fragetypen

	Fragensammlung aufrufen

	Kurse und Inhalte wiederverwenden
	Sicherung eines Kurses
	Sicherung einer einzelnen Aktivität
	Wiederherstellung eines Kurses bzw. einer Aktivität
	Kurs zurücksetzen
	Kurs importieren

	Für Administrator:innen:  Sonstige Hinweise und empfehlenswerte Einstellungen
	Papierkorb
	Wiederherstellen von gelöschten Kursinhalten
	Wiederherstellen von gelöschten Kursen

	Filter aktivieren
	Texteditoren konfigurieren
	Upload großer Dateien
	Eingerückte Darstellung von Kursinhalten erlauben
	Verwendung von Unterabschnitten
	Verwendung von BigBlueButton
	Plugins deaktivieren
	Datenschutzanfragen


